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Forensic Video Analysis Test 24-5581

The Forensic Video Analysis test consisted of evidence data acquired from an iPhone 11 Pro Max; iOS 16.6.1. 
Participants were asked to enhance and clarify the video and produce a derivative that makes it easier to see and 
understand the incident.

SAMPLE PREPARATION/VALIDATION
A predetermined staged event involving a vehicle of interest parked outside of a small office building shortly before a 
fire broke out in the building was executed and video recorded.This event was recorded using a single camera view 
captured by an iPhone and stored in the cloud.

The .MOV file was zipped and uploaded to the CTS Portal. A MD5 and SHA1 hash value was calculated and provided 
for the compressed file to validate the integrity of the downloaded file.

VERIFICATION
Predistribution results were consistent with each other and the manufacturer's preparation information. The 
combination of internal test validation and the responses received from predistribution testing structured the final 
questions utilized in this test. The following list of tools were utilized in the validation of this test: Amped FIVE (revisions 
33279 and 34212), Jacksum (version 1.7.0), FFmpeg (versions 6.1 and 7.0.1), FFprobe (version 6.1 and 7.0.1), and 
ExifTool (versions 12.78 and 12.93). CTS does not endorse any particular tools.

Manufacturer's Information

SCENARIO PROVIDED TO PARTICIPANTS

A vehicle of interest was parked outside of a small office building shortly before a fire broke out in the building, which 
resulted in millions of dollars in damage. Arson is suspected as the cause. A surveillance camera was attached to the 
exterior wall of the building and captured a portion of the front of the vehicle but at an extreme angle (i.e., the camera 
sensor is nearly perpendicular to the front plane of the vehicle) just as power was lost to the building due to the fire. 
The recorded video was stored in the cloud. The surveillance camera was loosely mounted to the wall and a large air 
handler nearby caused the camera to vibrate during capture. 

A video file export of the designated recording was made by investigators in QuickTime MOV format. Investigators 
request video enhancement of the MOV file to see the license plate of the vehicle more clearly.
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Manufacturer's Information, continued

 Question  Manufacturer ' s Response  -  Examination Questions

 What is the SHA - 256  hash value of the MOV file ?1-1

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5

 What is the reported frame rate of the MOV file ?  ( report as a numeric value in fps )1-2

29.97 FPS (MediaInfo reports minimum and maximum frame rates as 28.571 and 30 FPS, 
respectively)

 What are the pixel dimensions of the MOV file ?1-3

1920 x 1080

 What is the bit rate of the recorded video in the MOV file ?1-4

16015859 bits per second (bps) [MediaInfo], 16016781 bps [FFprobe], 16 or 16.0 Megabits per 
second (Mbps) [MediaInfo and ExifTool]. Also acceptable are any of these expressed in kilobits per 
second (kbps): 16000 kbps, 16015.859 kbps, or 16016.781 kbps.

 How many frames are there in the MOV file ?1-5

159

 Is there an audio track present in the MOV file ?1-6

No

 Question  Manufacturer ' s Response  -  Enhanced Video Examination

 Note methods or tools used and settings for the video enhancement here .2-1

This was a free form question on methods and tools used. No manufacturer's response is provided.
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Summary Comments

This test was designed to allow participants to assess their proficiency in data verification, media characterization, data 

analysis and video enhancement using their own tools and methods. The participants were provided with data acquired 

from an iPhone 11 Pro Max camera and were asked to answer questions as well as make enhancements to the video. 

Refer to the Manufacturer’s Information for preparation details.

A total of 65 participants returned results for this test.

A variety of software tools were used by participants during examination with 74% reporting the tool Amped FIVE.

All six examination questions achieved consensus. In a separate section of this test, participants were asked to perform 

specific enhancement steps to the video file and submit these enhanced video files and still images to CTS. An expert 

reviewed the files submitted by participants and those observational notes are presented in Table 3.

CTS recognizes that examiners in different organizations may not perform all the same tasks. In order to allow 

participants and accrediting bodies to objectively measure enhancement and/or investigative skills, this test may have 

included questions that are outside the laboratory’s normal reporting procedures.
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Forensic Video Examination Responses

TABLE 1
 Question 1- 1 :  Examination Questions

Question 1-1: What is the SHA-256 hash value of the MOV file?

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5 Manufacturer ' s 
 Response:

ResponseWebCode

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F52PMJBM

2C8553B7EE8CD7F314CF94498BF4112FBF2E9C352RNRFW

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F52XE2PV

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f537NQ4U

1. 84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f539RLMW

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F53QAKUF

SHA256 84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F53QWT2Y

159f333463cd8ab1aba272f1bb34dfc984dc774555f1173ba28699a2a41870694YJ98E

Sha-256 - 84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f56XMCVP

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f573WT6D

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F57EQ9RU

84A361708461D90DC418E56BE6B7E0445799564F92108926A97E16903785553F57NBD2E

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f58BK3RE

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f58KV6DE

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F58WK66G

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f59Y4FGR

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5A8X93Q

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5A9N7GP

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5ACNHCP

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5AV4RDP

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5B23TTA

BB19EA4CEB46F4FDF0F895D1ADB723D4275D22B224CC3EF3E0D56EC111AA1D14B3JPKA

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5B7J2GA

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5BJH3TB

84A36170846D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5CACG79

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5CC4FK8

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5CJ33AL

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5CRD6VM

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5DBZD7M
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TABLE 1
 Question 1- 1 :  Examination Questions

ResponseWebCode

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5DJW977

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5EDKJ6A

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5FKZPEL

The SHA-256 hash value of the MOV file is 
84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5m.

GJLF2E

SHA256 hash: 84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5GWBEV3

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5HNZDA2

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5HVA2KE

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5J8J2UD

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5JZNYT2

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5KV8Q63

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5LNKKHF

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5LVHCQA

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5M23ULW

5f4c6b24985ba5cf67b8bf800e9acb433039b6f551dcd68adfd5b21acda89ef1MM3TAV

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5N48MEA

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5NJMLLV

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5NQHNM8

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5NQZUMX

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5P3V8K9

7fb77dc0763dc4995b7daf772c554f63795c51e00ef971597f3bf6f7e4805102PFWY4R

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5PXEYWA

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5Q8K8C9

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5QXTL8W

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5REFN4Q

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5RF9GYA

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5RQ6K34

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5RZEPFU

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5T9PB33

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5TWCB7A

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5TXJT46

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5U8M2LQ

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5V2X39M

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5VCGJZT
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TABLE 1
 Question 1- 1 :  Examination Questions

ResponseWebCode

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5VKRLLU

84A361708461D90DC418E56BE6B7E045799564F9210B926A97E16903785553F5XDJYK6

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5XGLWVX

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5XV4PJ4

Question 1-1: What is the SHA-256 hash value of the MOV file?

84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5 Consensus Result:
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TABLE 1
 Question 1- 2 :  Examination Questions

Question 1-2: What is the reported frame rate of the MOV file? (report as a numeric value in fps)

29.97 FPS (MediaInfo reports minimum and maximum frame rates as 28.571 and 30 FPS, 
respectively)

 Manufacturer ' s 
 Response:

ResponseWebCode

29.9702PMJBM

29.972RNRFW

29.972XE2PV

29.9737NQ4U

29.971739RLMW

29.973QAKUF

29.9703QWT2Y

304YJ98E

29.976XMCVP

29.9773WT6D

29.977EQ9RU

299707NBD2E

29.97008BK3RE

29.97008KV6DE

29.978WK66G

29.9709Y4FGR

29.97A8X93Q

29.9717A9N7GP

29.97ACNHCP

29.970AV4RDP

29.97B23TTA

29.9717B3JPKA

29.970B7J2GA

29.970BJH3TB

29.970CACG79

29.972CC4FK8

29.97CJ33AL

29.97CRD6VM

29.97DBZD7M

29.97DJW977

29.970EDKJ6A
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TABLE 1
 Question 1- 2 :  Examination Questions

ResponseWebCode

29.97FKZPEL

29.970GJLF2E

29.97GWBEV3

29.9HNZDA2

29.97HVA2KE

29.97J8J2UD

29.97JZNYT2

29.97KV8Q63

29.97LNKKHF

29.970LVHCQA

29.97M23ULW

30MM3TAV

29.97N48MEA

29.97NJMLLV

29.97NQHNM8

29.97NQZUMX

29.97P3V8K9

29.970030PFWY4R

29.9700PXEYWA

29.970Q8K8C9

29.97QXTL8W

29.97REFN4Q

29.9717RF9GYA

29.97RQ6K34

29.97RZEPFU

29.970T9PB33

29.97TWCB7A

29.970TXJT46

29.97U8M2LQ

29.97V2X39M

29.970030VCGJZT

29.97VKRLLU

29.97XDJYK6
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TABLE 1
 Question 1- 2 :  Examination Questions

ResponseWebCode

29.970XGLWVX

29.97XV4PJ4

Question 1-2: What is the reported frame rate of the MOV file? (report as a numeric value in fps)

29.97 FPS Consensus Result:
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TABLE 1
 Question 1- 3 :  Examination Questions

Question 1-3: What are the pixel dimensions of the MOV file?

1920 x 1080 Manufacturer ' s 
 Response:

ResponseWebCode

1920 x 10802PMJBM

1920 x 10802RNRFW

1920 x 10802XE2PV

1920 x 108037NQ4U

3. 1920/1080 (1.778:1)39RLMW

1920 × 10803QAKUF

1920 X 1080 (16:9 - 1.778:1)3QWT2Y

1920 x 10804YJ98E

1920 x 10806XMCVP

1920 x 108073WT6D

1920 x 10807EQ9RU

1920 X 10807NBD2E

1920 x 10808BK3RE

1920 x 10808KV6DE

1920 x 10808WK66G

1920 x 1080 (around 2,1 megapixels)9Y4FGR

1920 x 1080A8X93Q

1920/1080 (1.778:1)A9N7GP

1920 x 1080ACNHCP

1920/1080 (1.778:1)AV4RDP

1920 x 1080 pxlsB23TTA

1920/1080B3JPKA

1920 x 1080B7J2GA

1920 x 1080BJH3TB

1920 x 1080CACG79

1920*1080CC4FK8

1920 x 1080CJ33AL

1920 x 1080CRD6VM

1920 x 1080DBZD7M

Width: 1920 pixels Height: 1080 pixelsDJW977

1920 x 1080EDKJ6A
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TABLE 1
 Question 1- 3 :  Examination Questions

ResponseWebCode

1920 x 1080FKZPEL

The pixel dimensions of the MOV file are 1920 x 1080.GJLF2E

1920 x 1080GWBEV3

1920 pixels x 1080 pixelsHNZDA2

1920 X 1080HVA2KE

1920 x 1080J8J2UD

1920 x 1080JZNYT2

Width (pixels): 1920, Height (pixels): 1080KV8Q63

1920 x 1080LNKKHF

1920 x 1080LVHCQA

1920 x 1080M23ULW

1920 x 1080MM3TAV

1920 x 1080N48MEA

1920 x 1080NJMLLV

1920 x 1080NQHNM8

1920 x 1080NQZUMX

1920 x 1080P3V8K9

1920 x 1080PFWY4R

1920 x 1080PXEYWA

1920 x 1080Q8K8C9

1920 x 1112 (image area 1920 x 1080)QXTL8W

1920*1080REFN4Q

1920 x 1080RF9GYA

1920 x 1080RQ6K34

1920 X 1080RZEPFU

1920 x 1080T9PB33

1920 x 1080TWCB7A

1920 x 1080TXJT46

1920 x 1080U8M2LQ

1920 x 1080V2X39M

1920 x 1080VCGJZT

1920 x 1080VKRLLU

1920 x 1080XDJYK6
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TABLE 1
 Question 1- 3 :  Examination Questions

ResponseWebCode

1920 x 1080XGLWVX

1920 x 1080XV4PJ4

Question 1-3: What are the pixel dimensions of the MOV file?

1920 x 1080 Consensus Result:
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TABLE 1
 Question 1- 4 :  Examination Questions

Question 1-4: What is the bit rate of the recorded video in the MOV file?

16015859 bits per second (bps) [MediaInfo], 16016781 bps [FFprobe], 16 or 16.0 Megabits 
per second (Mbps) [MediaInfo and ExifTool]. Also acceptable are any of these expressed in 
kilobits per second (kbps): 16000 kbps, 16015.859 kbps, or 16016.781 kbps.

 Manufacturer ' s 
 Response:

ResponseWebCode

16 Mb/s2PMJBM

16 mb/s2RNRFW

16.0 Mb/s2XE2PV

16.x37NQ4U

16993 kbps39RLMW

16.0 Mb/s3QAKUF

16.0 Mb/s3QWT2Y

16.0 mb/s4YJ98E

16 Mb/s6XMCVP

16.0 Mb/s73WT6D

16.0 Mb/s7EQ9RU

16.0 Mb/s7NBD2E

16993 kbps8BK3RE

16993 kbps8KV6DE

16993 kbps8WK66G

BitRate: 16 Mb/s9Y4FGR

16.0 Mb/sA8X93Q

16993A9N7GP

16.0 Mb/sACNHCP

16 MbpsAV4RDP

16019477 (16.0 Mb/s)B23TTA

16.0 Mb/sB3JPKA

16.0 Mb/sB7J2GA

16.0 Mb/sBJH3TB

16.0 MbpsCACG79

16 MbpsCC4FK8

16 mpbsCJ33AL

16 Mb/sCRD6VM

16 MbpsDBZD7M

16993 kbpsDJW977
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TABLE 1
 Question 1- 4 :  Examination Questions

ResponseWebCode

16.0 Mb/sEDKJ6A

16.0 Mb/second (Media Info), 16.993 Mb/second (Windows), 15.077 Mb/second (VLC)FKZPEL

The bit rate of the recorded video in the MOV file is 16.0 MB/S.GJLF2E

16 Mb/sGWBEV3

16 Mb/sHNZDA2

16 MbsHVA2KE

16.0 Mb/sJ8J2UD

16.0 Mb/sJZNYT2

16.0 Mb/s.KV8Q63

15.7 Mb/sLNKKHF

16.0 Mb/sLVHCQA

16.016781M23ULW

16.0 mb/sMM3TAV

16.016781 Mbit/sN48MEA

16 Mb/sNJMLLV

16 MbpsNQHNM8

16 Mb/sNQZUMX

16016 kb/sP3V8K9

16.0 Mb/sPFWY4R

16.0 Mb/sPXEYWA

16.0 Mb/sQ8K8C9

16993 kbpsQXTL8W

16 MbpsREFN4Q

16993 kbpsRF9GYA

16.0 Mb/sRQ6K34

16993 KB/SCRZEPFU

8 bitsT9PB33

16.0 Mb/sTWCB7A

16.0mb/sTXJT46

16.0 Mb/sU8M2LQ

16.0 Mb/sV2X39M

16 Mb/sVCGJZT

16.0 Mb/sVKRLLU
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TABLE 1
 Question 1- 4 :  Examination Questions

ResponseWebCode

16993XDJYK6

16.0 Mb/sXGLWVX

10.0 Mb/sXV4PJ4

Question 1-4: What is the bit rate of the recorded video in the MOV file?

16 Mb/s Consensus Result:
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TABLE 1
 Question 1- 5 :  Examination Questions

Question 1-5: How many frames are there in the MOV file?

159 Manufacturer ' s 
 Response:

ResponseWebCode

1592PMJBM

1592RNRFW

1592XE2PV

15937NQ4U

15939RLMW

1593QAKUF

1593QWT2Y

1594YJ98E

1596XMCVP

15973WT6D

1597EQ9RU

159 Frame7NBD2E

1598BK3RE

1598KV6DE

1598WK66G

159 (include frame 0)9Y4FGR

159A8X93Q

159A9N7GP

159ACNHCP

159 framesAV4RDP

159 framesB23TTA

159B3JPKA

159B7J2GA

159BJH3TB

159CACG79

159CC4FK8

158CJ33AL

159CRD6VM

159DBZD7M

158DJW977

159EDKJ6A
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TABLE 1
 Question 1- 5 :  Examination Questions
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159FKZPEL

There are 159 frames in the MOV file.GJLF2E

159GWBEV3

159 framesHNZDA2

159HVA2KE

158J8J2UD

159JZNYT2

159KV8Q63

159LNKKHF

159LVHCQA

159M23ULW

159MM3TAV

159N48MEA

159NJMLLV

158 framesNQHNM8

159NQZUMX

159P3V8K9

159PFWY4R

159PXEYWA

159Q8K8C9

158QXTL8W

159REFN4Q

159RF9GYA

159RQ6K34

159RZEPFU

159T9PB33

159TWCB7A

159TXJT46

159U8M2LQ

159V2X39M

159VCGJZT

159VKRLLU

159XDJYK6
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159 frames total - (0 to 158)XGLWVX

159XV4PJ4

Question 1-5: How many frames are there in the MOV file?

159 Consensus Result:

( 19 )Printed:  09-October-2024 Copyright ©2024 CTS, Inc



Forensic Video Analysis Test 24-5581

TABLE 1
 Question 1- 6 :  Examination Questions

Question 1-6: Is there an audio track present in the MOV file?

No Manufacturer ' s 
 Response:

ResponseWebCode

No2PMJBM

No2RNRFW

No2XE2PV

No37NQ4U

No39RLMW

No3QAKUF

No3QWT2Y

No4YJ98E

No6XMCVP

No73WT6D

No7EQ9RU

No7NBD2E

No8BK3RE

No8KV6DE

No8WK66G

No9Y4FGR

NoA8X93Q

NoA9N7GP

NoACNHCP

NoAV4RDP

NoB23TTA

NoB3JPKA

NoB7J2GA

NoBJH3TB

NoCACG79

NoCC4FK8

NoCJ33AL

NoCRD6VM

NoDBZD7M

NoDJW977

NoEDKJ6A
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NoFKZPEL

NoGJLF2E

NoGWBEV3

NoHNZDA2

NoHVA2KE

NoJ8J2UD

NoJZNYT2

NoKV8Q63

NoLNKKHF

NoLVHCQA

NoM23ULW

NoMM3TAV

NoN48MEA

NoNJMLLV

NoNQHNM8

NoNQZUMX

NoP3V8K9

NoPFWY4R

NoPXEYWA

NoQ8K8C9

NoQXTL8W

NoREFN4Q

NoRF9GYA

NoRQ6K34

NoRZEPFU

NoT9PB33

NoTWCB7A

NoTXJT46

NoU8M2LQ

NoV2X39M

NoVCGJZT

NoVKRLLU

NoXDJYK6
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ResponseWebCode

NoXGLWVX

NoXV4PJ4

Question 1-6: Is there an audio track present in the MOV file?

No Consensus Result:
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Forensic Video Enhancement Responses
TABLE 2

 Question 2- 1 : Enhanced Video Examination 
Question 2-1: Note methods or tools used and settings for the video enhancement here.

This was a free form question on methods and tools used. No manufacturer's response is 
provided.

 Manufacturer ' s 
 Expected Response:

ResponseWebCode

AmpedFive: Rotate, Perspective stabilization, Correct Perspective, Crop, Motion deblurring, Unsharp 
masking, Add text - $POSITIONFRAMES. Video writer - MP4, H.264 encoding, visually lossless. Image 
writer - BMP

2PMJBM

The video file was loaded into Amped FIVE forensic software. The video was first rotated -180 degrees. 
The video was cropped to the license plate area of the image (x: 1281, y: 727, w: 317, h: 265). 
Overall contrast improvement was conducted with the Levels filter, set to 176 Highlights, 79 Midtones, 
and leaving Shadows at 0. A local stabilization filter was applied using static tracking on the license 
plate area (reference coordinates 0: x: 125, y: 107, w: 31, h: 80). The correct perspective filter was 
applied to bring the license plate parallel to the image plane using a roughly 2:1 width to height ratio 
(source points 125, 104 - 156, 129 - 153, 184 - 121, 157; target selection x: 154, y: 103, w: 65, h: 
41). The position of each frame way applied to the video via text overlay. The resulting video was 
exported with H264 encoding in an MP4 format. The best single image of the video, Frame 158, was 
exported in the BMP format.

2RNRFW

method and notes made in Amped Five report attached. [Report was not included]2XE2PV

The tool used for this proficiency test was VideoCleaner, version 5.8; Copyright, Forensic Protection, 
2018. Specific settings used, and their parameters for this video were set as follows: 1. Turn on 
'Specialty' tools. 2. Rotate Video 180 degrees. (For some reason, this video loaded upside down, 
requiring the video to be rotated.) 3. Crop: (set to '%'); Frame 0; Left: 70; Right: 22; Top: 75; Bottom: 
12; Frame 158; Left: 70; Right: 24; Top: 80; Bottom: 8. 4. Perspective Changer - In order to final 
setting: Top Right (x-axis): 80, 75, 70; Bottom Right (x-axis): 80, 75, 70; Top Left (x-axis): 20, 25, 30; 
Bottom Left (x-axis): 20, 25, 30 5. Tools - Backlight: ON. The file was exported from VideoCleaner as 
an .AVI, and then imported into VLC Media Player. It was then exported from VLC Media Player as an 
MP4/H.264 file for submission. Assessed final reading on suspect license plate: "4NSC EJP" State of 
issue unknown.

37NQ4U

Axon Investigate Pro 4.1.1 was used for enhancement. Lens Correction: K1 = -0.17 K2 = -0.55 to 
Stabilize to Standard Output - Best Quality. Input(s) 1. Crop. Lens Correction Stabilize 1.mp4 – file. 
F:\24-5581 Video\Lens Correction Stabilize 1.mp4. File Hash (SHA256): 
096927ff849c2f315f5b7e1a7164a0d3cd59d3297e98fbf1cee27279cfbd4688. File Hash (MD5): 
95fd94f757dd19ebbe7ce15d897369cd. Workflow. Crop – (x, y) = (1368, 726); size = 272x318. 
Output to MP4 – transcode video = H264; set even width/height = True; change pixel format = 
Yuv420P; remove delta frames = False; compression quality = 0; compression speed = Medium; 
transcode audio = Aac. Path: F:\24-5581 Video\cropped.mp4. Outputs. F:\24-5581 
Video\cropped.mp4. File Hash (SHA256): 
1a94a8713e00d342af44eab0df686d8db743798e99d3b90d2d86be1e0f883d1e. File Hash (MD5): 
31147958fd4a4fb313dbf91411bf0a26. All Frames extracted from cropped.mp4 file. Parts E could not 
be completed by Axon Investigate Pro. The application does not allow the type of overlay.

39RLMW

Amped 5 was used to analyze and process the video file. The filters used were: Rotate 180°; Correct 
Perspective to register the registration tag to a standard 2:1 rectangle; Perspective Stabilization to 
stabilize the registered frames; Crop; Histogram Equalization to improve the dynamic range; Retinex to 
improve the contrast; Levels to refine the contrast further; Wiener filter to reduce noise and distortion 
artifacts; Add Text to annotate the frame number; and Video Writer to generate the MPEG-4 file.

3QAKUF
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ResponseWebCode
Using QuickHash v3.2.0, compared the downloaded file with the hash provided in the scenario, and 
they matched. Also using QuickHash, recorded the SHA-256 hash value in question 1-1. Brought the 
video into Amped FIVE (Build date:20220428 Revision:24474) to work on it. I did the following steps in 
this order; video loaded; rotate; correct perspective; levels; local stabilization; crop; resize; add text; 
image writer(for frames153;155;158); video writer; range selector; frame averaging; image writer(for 
frame average). See the report generated by the program Apmed Five for the details of each step done. 
I am going under the assumption, that I have uploaded the images from the other night because there is 
no way of checking what was uploaded and what I may not done yet.

3QWT2Y

the above instructions are applied in the amped five software that was used for the analysis and the steps 
are shown.

4YJ98E

Amped Five revision 33279. VideoMaterial-instructions 2.BMP – - Perspective corrected, rotated, 
cropped, frames selected, stabilization applied, cropped, perspective corrected, magnification applied, 
colours adjusted. VideoMaterial-instructions 3 grayscale.BMP – - Perspective corrected, rotated, 
grayscale conversion, cropped, frames selected, stabilization applied, cropped, perspective corrected, 
magnification applied, colours adjusted. VideoMaterial (version 2).BMP – - Perspective corrected, 
magnification applied, rotated, perspective corrected, levels adjusted, cropped, magnification applied 
VideoMaterial-instructions with overlay.MP4 – - Perspective corrected, rotated, stabilization applied, 
cropped, magnification applied, text overlayed. Refer Amped Five report. [Report was not included]

6XMCVP

All processes described below were performed using Amped FIVE. - Stabilization, perspective correction 
and crop: Video stabilization was achieved using Amped FIVE's 'Perspective Stabilization' filter, with the 
tracking target area encompassing the front grille, license plate, and headlights. (selection area: 173, 
110 - 525, 110 - 525, 350 - 173, 350 | motion type: Perspective | Tracking method: Static Tracking | 
Interpolation: Bicubic) The video was initially recorded with the camera upside down, and the metadata 
indicated a 180° rotation during playback. A 180° rotation filter was applied using Amped FIVE. 
Perspective correction was performed, and size adjustments were applied to achieve a 2:1 ratio on the 
license plate. (Source Points: 1405, 828 - 1437, 853 - 1435, 916 - 1403, 886 | Target Selection: x: 
1403, y: 827, w: 180, h: 90) Image was cropped around the license plate to as instructed (Selection: x: 
1340, y: 757, w: 320, h: 240) - Video enhancement: Amped FIVE's curves adjustment filter was applied 
to enhance readability by increasing the contrast, observing the license plate text area, and using the 
following parameters: Value= x: 0, y: 0 / x: 44, y: 51 / x: 83, y: 95 / x: 125, y: 161 / x: 170, y: 192 / 
x: 255, y: 255 Red = x: 0, y: 0 / x: 210, y: 255 Green = x: 0, y: 0 / x: 220, y: 254 Blue = x: 8, y: 0 / 
x: 57, y: 70 / x: 107, y: 126 / x: 143, y: 168 Along with the video enhancement, frames 1, 3, 45, 134, 
141, 151 and 155 were chosen to prepare a frame average (export described below). - Add text overlay 
and clip export: Amped FIVE's "Add Text" filter was used to overlay the frame numbers in the lower right 
corner. Starting with the first frame as frame 0 The resulting video was exported as mp4 using h264 
codec. A Constant Frame Rate of 29.97 and a Constant Rate Factor of 1 (visually lossless) were used. - 
Frame selection: Frame 3 was selected and saved as VideoMaterial_Optimized-frame003.tif. Frame 
150 was selected and saved as VideoMaterial_Optimized-frame150.tif. Frames 1, 3, 45, 134, 141, 
151 and 155 were averaged and saved as VideoMaterial-FrameAVG.tif Note: Detailed process and 
settings available using Amped FIVE's project and reports. [Participant submitted data in a format that 
could not be reproduced in this report].

73WT6D
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Amped FIVE Report. Report Generation: 2024-07-23 15:34:11. Project Name: 2024 Profficiency Test 
24-5581. Author: [Name]. Description: Software version info: Build date: 20230704. Revision: 29850. 
Platform: Operating System: Microsoft Windows, 64 bit. CPU Model: Intel(R) Core(TM) i9-10900KF 
CPU @ 3.70GHz. Project File: VideoMaterial_FINAL.afp. Summary: VideoMaterial. Video Loader: 
Loads a video from file. Rotate: Rotates the image. Local Stabilization: Stabilizes a shaking video by 
keeping the current selection steady. The object of interest must be present in all frames. Supports 
different stabilization modes. Correct Perspective: Corrects the perspective of a plane of interest within 
the image (image rectification). Crop: Crops a region of interest of the image. Exposure: Adjusts the 
image exposure. Smart Adjust: Improves the local contrast of an image minimizing halo artifacts and the 
clipping of highlights. Unsharp Masking: Sharpens the image using an unsharp masking filter. Add Text: 
Adds text to the image. Supports several macros to dynamically change the content of the text. Font, 
color, size and position can be customized. This filter only supports 3-channel images. If a 
single-channel image is used, the filter will automatically convert it to a 3-channel image. Video Writer: 
Writes the current video to a file. Sparse Selector: Selects a list of frames that are defined by the user. 
Sequence Writer: Writes all frames as image files. 1/6 VideoMaterial Video Loader Loads a video from 
file. Details: The Video Loader decodes a standard-format video file into a sequence of frames that can 
be displayed and processed. Parameters: File: ../../VideoMaterial.MOV Path of the video to load. Video 
Engine: FFMS Video decoder to use. Color Range: Limited Uses the color range specified in the video 
file or force it to full or limited (16-235). Works only with the FFMS Video Engine. Chroma Upsampling: 
Accurate Rounding (Slower) Selects the chroma upsampling method. Applies only to FFMS-based video 
engines. Audio Stream: None Audio Stream selection, useful when multiple streams are available. 
Original File: Original video file that has been converted from a proprietary DVR format or otherwise 
imported. Concatenate File List: List of files that were concatenated as part of the conversion process 
Additional Information: Video Streams: 1 Number of video streams in the video Audio Streams: 0 
Number of audio streams in the video Subtitle Streams: 0 Number of subtitle streams in the video Rotate 
Rotates the image. Details: The Rotate filter rotates the image by an arbitrary angle. If the rotation angle 
is not a multiple of 90 degrees, the selected interpolation algorithm is used, otherwise the original pixel 
values are simply transposed. Parameters: Angle: 180 Rotation angle. Resize Image to Fit: true If 
unchecked, the image size is retained but portions of the image could be rendered outside the frame. 
Interpolation: Bicubic Interpolation algorithm used when the image is resized. Background Color: 
#000000 Color used to fill the portions of the frame outside the original image. Additional Information: 
This filter has no additional information. References: Anil. K. Jain, "Fundamentals of Digital Image 
Processing", Prentice Hall, pp. 253–255, 1989. ISBN: 0-13-336165-9. Anil. K. Jain, "Fundamentals of 
Digital Image Processing", Prentice Hall, pp. 320–322, 1989. ISBN: 0-13-336165-9. R. Keys, "Cubic 
convolution interpolation for digital image processing", in IEEE Transactions on Acoustics, Speech, and 
Signal Processing, Vol. 29, No. 6, pp. 1153-1160, December 1981. 
https://doi.org/10.1109/TASSP.1981.1163711 Hsieh Hou and H. Andrews, "Cubic splines for image 
interpolation and digital filtering", in IEEE Transactions on Acoustics, Speech, and Signal Processing, Vol. 
26, No. 6, pp. 508–517, December 1978. https://doi.org/10.1109/TASSP.1978.1163154 Local 
Stabilization Stabilizes a shaking video by keeping the current selection steady. The object of interest 
must be present in all frames. Supports different stabilization modes. Details: The Local Stabilization tool 
shifts the different frames of a video horizontally and/or vertically in order to correct instability. The offset 
to be applied is calculated by obtaining the maximum of the cross-correlation function between each 
frame and a template, which is obtained by the reference area copied from the reference frame. 
Parameters: Background Color: #000000 Color used to fill the area outside the original image. 
Selection: Static Tracking Reference Selection(s) 0: x: 1399, y: 819, w: 59, h: 110 The selection where 
the filter is applied to. It may be the whole image, a static region, or a region containing a tracked 
object of interest. Additional Information: This filter has no additional information. 2/6 References: Anil. 
K. Jain, "Fundamentals of Digital Image Processing", Prentice Hall, pp. 400–402, 1989. ISBN: 
0-13-336165-9. Correct Perspective Corrects the perspective of a plane of interest within the image 
(image rectification). Details: Correct Perspective maps a desired quadrangular region to a rectangular 
one, which corresponds to making the plane of interest parallel to the image plane. The pixel values are 
interpolated with a bicubic algorithm. The ratio between width and height of the output rectangle can be 
set by the user by drawing a selection or computed automatically from the input points. The automatic 

7EQ9RU

( 25 )Printed:  09-October-2024 Copyright ©2024 CTS, Inc



Forensic Video Analysis Test 24-5581

TABLE 2
 Question 2- 1 : Enhanced Video Examination 

ResponseWebCode
computation should only be used if the image is not cropped (i.e. the optical axis of the lens coincides 
with the center of the image) and there's no excess of distortion; in any case, the results of the automatic 
computation should not be relied upon for forensic purposes. The original quadrangular region can be 
refined by selecting its corners a second time on the rectified image, where they are better discernible. 
Parameters: Source Points: 1406, 833 - 1435, 855 - 1435, 912 - 1403, 884 Quadrilateral to 
transform into a rectangle. Target Selection: x: 1403, y: 842, w: 139, h: 71 Target rectangle to map the 
source points to. Additional Information: This filter has no additional information. References: Anil. K. 
Jain, "Fundamentals of Digital Image Processing", Prentice Hall, pp. 320–322, 1989. ISBN: 
0-13-336165-9. R. Keys, "Cubic convolution interpolation for digital image processing", in IEEE 
Transactions on Acoustics, Speech, and Signal Processing, Vol. 29, No. 6, pp. 1153-1160, December 
1981. https://doi.org/10.1109/TASSP.1981.1163711 Hsieh Hou and H. Andrews, "Cubic splines for 
image interpolation and digital filtering", in IEEE Transactions on Acoustics, Speech, and Signal 
Processing, Vol. 26, No. 6, pp. 508–517, December 1978. 
https://doi.org/10.1109/TASSP.1978.1163154 Crop Crops a region of interest of the image. Details: 
The Crop tool produces an output image which is only the selected square or rectangular region of the 
input image. Parameters: Selection: x: 1339, y: 765, w: 295, h: 205 The selection where the filter is 
applied to. It may be the whole image, a static region, or a region containing a tracked object of 
interest. Additional Information: This filter has no additional information. Exposure Adjusts the image 
exposure. Details: The Exposure tool performs a non-linear mapping of the input image values. It adjusts 
the image gamma applying a power function that has three parameters: Exposure, Offset and Recover. 
Exposure modifies the pixel values in the midtone-to-white range with minimal effect on the shadows. 
Decreasing (respectively increasing) the Offset darkens (resp. lightens) the pixel values in the 
midtone-to-black range with minimal effect on the highlights. Recover controls the overall brightness of 
the image. Parameters: Exposure: 1 Adjusts the exposure of the image. Offset: 0.1000 Adds or subtracts 
an offset to the pixel values. Recover: 0.7943 Recovers the saturated pixels of the image. Selection: 
Whole Image The selection where the filter is applied to. It may be the whole image, a static region, or a 
region containing a tracked object of interest. Additional Information: This filter has no additional 
information. References: Anil. K. Jain, "Fundamentals of Digital Image Processing", Prentice Hall, pp. 
234–241, 1989. ISBN: 0-13-336165-9. Smart Adjust Improves the local contrast of an image 
minimizing halo artifacts and the clipping of highlights. Details: The Smart Adjust filter increases the 
contrast of an image by estimating a local minimum and maximum at each point, and then stretching 
the input intensity values, so that the local minimum becomes black and the local maximum becomes 
white. This can compensate for an uneven illumination or color casts, 3/6 reduce the effect of fog or 
haze, or both. The local mimimum and maximum are computed using a constrained edge-preserving 
low-pass filter, described in (Guarnieri, Marsi and Ramponi, 2011): the constrained property guarantees 
than the details in the input image are always preserved without clipping, and the edge-preserving 
property avoids or strongly reduces the formation of halos around the sharp edges, which often affect 
local contrast-enhancement filters such as the Homomorphic Filter or Retinex. The Smart Adjust filter can 
also operate in one direction only: increase the pixel values, preserving the black, or decrease the pixel 
values, preserving the white. On color images, each RGB channel is processed independently. 
Parameters: Mode: Equalization The type of operation performed by the filter. Strength: 50 Adjusts the 
amount of contrast enhancement produced by the filter. Edge Threshold: 0 Adjusts the edge-preserving 
property of the filter. A value of 0 uses a different edge-detection method that does not require 
adjustment. Additional Information: This filter has no additional information. References: Gabriele 
Guarnieri, Stefano Marsi and Giovanni Ramponi, "High Dynamic Range Image Display With Halo and 
Clipping Prevention", in IEEE Transactions on Image Processing, Vol. 20, No. 5, pp. 1351-1362, May 
2011. https://doi.org/10.1109/TIP.2010.2092436 Unsharp Masking Sharpens the image using an 
unsharp masking filter. Details: The Unsharp Masking filter is implemented as a window-based operator, 
i.e. it relies on a convolution kernel to perform spatial filtering. The original image is first convolved with 
a Radius x Radius Gaussian kernel to produce its smoothed version, i.e. a low-passed image. The 
resulting image is then pixel subtracted from the original image in order to produce a description of 
image edges, i.e. a high-passed image. Only the pixel differences (edges) greater than certain Threshold 
values are retained, so that sharpening of small image details can be suppressed. In order to increase 
the sharpness of the original image, a percentage (proportional to Strength) of the thresholded 
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high-passed image is added back onto the original image. Parameters: Strength: 0.3500 Intensity of the 
sharpening effect: larger values provide increasing amounts of sharpening. Size: 99 Length, in pixels, of 
the side of the square filter window. High resolution images allow for a higher size. Threshold: 0 The 
minimum difference in pixel values that indicates an edge where sharpen must be applied. Areas of 
smooth tonal transition can be protected from the creation of blemishes in the facial, sky or water 
surface. Mode: Intensity Type of adjustment to be performed. Selection: Whole Image The selection 
where the filter is applied to. It may be the whole image, a static region, or a region containing a 
tracked object of interest. Additional Information: This filter has no additional information. References: 
Anil. K. Jain, "Fundamentals of Digital Image Processing", Prentice Hall, pp. 249–250, 1989. ISBN: 
0-13-336165-9. Add Text Adds text to the image. Supports several macros to dynamically change the 
content of the text. Font, color, size and position can be customized. This filter only supports 3-channel 
images. If a single-channel image is used, the filter will automatically convert it to a 3-channel image. 
Details: The Add Text adds textual information to the image. Parameters: Text: 
$ORIGINALPOSITIONFRAMES The text to add to the image. Text Style: bold 'segoe ui' 24 
windows-1252, #FFFFFF, Right, Bottom Text appearance and layout. Background Color: #000000 The 
color used to paint the rectangle underneath the text, if required. Background Shape: Text The shape of 
the colored background, if activated. Date Format: %Y-%m-%d %a: Abbreviated weekday name %A: 
Full weekday name %b: Abbreviated month name %B: Full month name %d: Day of month as decimal 
number (01 - 31) %m: Month as decimal number (01 - 12) %U: Week of year as decimal number, with 
Sunday as first day of week (00 - 53) %w: Weekday as decimal number (0 - 6; Sunday is 0) %W: Week 
of year as decimal number, with Monday as first day of week (00 - 53) %x: Date representation for 
current locale %y: Year without century, as decimal number (00 - 99) %Y: Year with century, as decimal 
number %z, %Z: Either the time zone name or time zone abbreviation, depending on registry settings; no 
characters if time zone is unknown 4/6 Time Format: %H:%M:%S.%l %H: Hour in 24-hour format (00 - 
23) %I: Hour in 12-hour format (01 - 12) %l: Milliseconds with leading zeros (000 - 999) %M: Minute 
as decimal number (00 - 59) %p: Current locale's A.M./P.M. indicator for 12-hour clock %S: Second as 
decimal number (00 - 59) %X: Time representation for current locale Start Page Number: 1 The first 
page for the Page Number macro. Selection: Whole Image The selection where the filter is applied to. It 
may be the whole image, a static region, or a region containing a tracked object of interest. Additional 
Information: This filter has no additional information. Video Writer Writes the current video to a file. 
Details: The Video Writer tool encodes all frames of the current clip to the specified video file format. 
Parameters: File: ../VideoMaterial-Final.mp4 Path of the file to save. Container and Video Codec: mp4 
- H264 Container and codec used to store the media stream(s). Audio Codec: None Codec used to 
write the audio stream. Frame rate: 29.9700 Frame rate (in frames per second) of the output video. 
Note that some video formats support only a limited set of frame rates, and the frame rate may influence 
some properties of the output video (e.g. the GOP size) for some codecs. Quality: Visually Lossless If a 
codec with quality control has been selected, the following options can be selected: Default: Uses a 
Constant Rate Factor of 18 High: Uses a Constant Rate Factor of 12 Visually Lossless: Uses a Constant 
Rate Factor of 1 HW Acceleration: None Enables encoding acceleration of the on-board Graphic 
Processing Unit. Acceleration will be tested when the filter is applied. Additional Information: Video 
Streams: 1 Number of video streams in the video Audio Streams: 0 Number of audio streams in the 
video Subtitle Streams: 0 Number of subtitle streams in the video Sparse Selector Selects a list of frames 
that are defined by the user. Details: The Sparse Selector tool outputs multiple frames taken from user 
selected positions from an input video. Parameters: Frames: 0, 158 List of selected frames. Additional 
Information: This filter has no additional information. Sequence Writer Writes all frames as image files. 
Details: The Sequence Writer tool encodes all the frames of the current clip to a sequence of the still 
images in the chosen format. Parameters: Output Folder: C:\Users\user\Desktop\2024 Prof 
Test\VideoMaterial-Final-240723153222 Destination folder where to save the images. Format: Portable 
Network Graphics Format used to encode the image file. First Frame Number: 0 Number of the first 
frame. Image Filename: Best Images Write Image Sequence PDF: false Filename: sequence 5/6 
Additional Information: This filter has no additional information. 6/6. [Participant submitted data in a 
format that could not be reproduced in this report].
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Open-source software Media Player Classic, version 1.7.9.145, used to change the perspective of the 
video. Open-source software VLC version 3.0.21, used to adjust the brightness of the video. Forensic 
software Omnivore version 1.5, which was used to stabilize the derived videos. The first video, titled 
'license plate cut,' has a dimension of 656 x 34 pixels, with a data rate of 4596 Kbps. The second video, 
titled 'StabilizedDerivedVideo,' has a dimension of 1916 x 1076 pixels, with a data rate of 42195 Kbps, 
in mp4 format. Additionally, two screenshots were taken from the videos using the same software, saved 
in Tiff format. Frame overlay in text form was performed using open-source software Kinovea version 
2023.1.2, represented as 0/135 in the 'license plate cut' video and as 0/154 in the second video, titled 
'StabilizedDerivedVideo.' Open-source software Adobe Photoshop version CS6 was used to enhance the 
images in Tiff format. The first image has a dimension of 486 x 327 pixels, and the second one has a 
dimension of 862 x 570 pixels. In these images, the vehicle's license plate number was processed, 
which, due to the camera's angle, made visualization difficult. However, characters on the license plate 
with similar characteristics to the following were observed: '? KLER,' with the '?' symbol representing the 
number whose characteristics could not be determined.

7NBD2E

The video file was analyzed and enhanced utilizing Amped FIVE software (Build version 34212). Two still 
images were chosen (in addition to the submitted MP4 file) but were not submitted because the 
submission portal would only allow one entry. These images are available upon request. The below 
listed filters were used during the video enhancement process: * Video Loader: Loads a video from file * 
File Info: Save file information and EXIF metadata on the report * Hash Code: Calculates the input file 
hash code to check data integrity when loading the project * Rotate: Rotates the image * Correct 
Perspective: Corrects the perspective of a plane of interest within the image. * Local Stabilization: 
Stabilizes a shaking video by keeping the current selection steady * Crop: Crops a region of interest of 
the image * Retinex: Corrects an uneven illumination in the image using the Retinex algorithm * Levels: 
Adjusts intensity and color levels * Averaging Filter: Smooths the image with an averaging filter * 
Laplacian Sharpening: Sharpens the image using a Laplacian filter algorithm * Frame Size: Resizes the 
image canvas * Video Writer: Writes the current video to a file * Annotate: Draws annotations over the 
image * Video Writer: Writes the current video to a file

8BK3RE
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Amped Five Software. Wondershare. Contrast: 8 Extends the intensity dif erence among pixels (linear 
gain). Brightness: 7 Adds or subtracts an of set to image pixels (bias). Mode: Linear The domain in 
which the image is mapped to. The Linear mode is the standard mode. The Logarithmic mode retains 
the black and white points and therefore prevents saturation. Selection: Whole Image The selection 
where the filter is applied to. It may be the whole image, a static region, or a region containing a 
tracked object of interest. Text: FRAME$ORIGINALPOSITIONFRAMES The text to add Start Page 
Number: 1 The first page for the Page Number macro. Selection: x: 352, y: 4, w: 79, h: 24 The 
selection where the filter is applied to. It may be the whole image, a static region, or a region containing 
a tracked object of interest Exposure: 0 Adjusts the exposure of the image. Offset: -0.0100 Adds or 
subtracts an of set to the pixel values. Recover: 1 Recovers the saturated pixels of the image. Selection: 
Whole Image The selection where the filter is applied to. It may be the whole image, a static region, or a 
region containing a tracked object of in Maximum Shift: 20 The maximum horizontal and vertical shifts 
(in pixels) to correct. Frames: 29 The number of frames to be computed for the stabilization. Background 
Color: #000000 Color used to fill the area outside the original image. Size: 1 Length of the blur line, 
expressed in pixels. Angle: 0 Angle of the blur direction, expressed in degrees with respect to the 
horizontal. Noise: 0.0100 Estimate of the noise-to-signal power ratio. Mode: Linear Select if using a 
classical linear PSF or two isolated points to correct replica issues. Thickness: 1 Thickness of the blur, 
expressed in pixels. This parameter takes also into account an optical deblurring component. Boundary 
Conditions: Edge Tapering Reduces ringing artefacts near the boundaries of the image. Output Aspect 
Ratio: 32:5 The Aspect Ratio of the output image, expressed as a fractional number (the symbols " / " 
and ":" can both be used to express the fractional number i.e. 4/3 or 16:9). Mode: Retain Height The 
dimension to keep fixed. Interpolation: Bicubic Interpolation algorithm used when the image is resized. 
Angle: 180 Rotation angle. Resize Image to Fit: true If unchecked, the image size is retained but portions 
of the image could be rendered outside the frame. Interpolation: Bicubic Interpolation algorithm used 
when the image is resized. Background Color: #000000 Color used to fill the portions of the frame 
outside the original image. [Participant submitted data in a format that could not be reproduced in this 
report].

8KV6DE

The video enhancement I used was a levels adjustment to brighten the image. I then used a sparse 
selector to select what I felt were the clearest frames, then used a frame average process to try and 
reduce the compression artifacts. This produces a single image rather than a video however so I have 
provided this (MJL-2-24-5581) as well as the video and still frames requested. Full details of the tools 
and settings can be seen in the report provided.

8WK66G

Software: hashMyFiles (file verification), MediaInfo (file information), exiftool (file information), Amped 
Five (video enhancement). In this part of the test (video enhancement instruction), our task was to 
improve the visibility of license plate numbers. We completed this task in two ways. Firstly, we performed 
all the steps in this part of the test and secondly apart of that we again performed all the steps in this 
part of the test but averaged only a few selected frames (148 to 158), which may contribute to better 
visibility of the numbers on the license plate. Below You can find tool and settings. 1st option: Amped 
Five (load file, rotation 180 degrees, local video stabilization, crop file, perspective correction, aspect 
ratio, superresolution, contrast, add frame numbers, save files). Results: VideoMaterial-[participant 
code]-9Y4FGR.mp4, VideoMaterial-[participant code]-9Y4FGR-153.png. 2nd option: Amped Five (load 
file, rotation 180 degrees, local video stabilization, crop file, select frames (from 148 to 158), frame 
averaging, perspective correction, aspect ratio, superresolution, contrast, save file). Result: 
VideoMaterial-[participant code]-9Y4FGR-averaging.png. Uploaded file name: File: Video-[participant 
code]-9Y4FGR.zip. SHA-256: 
b2dc277b5b7373113867262d81ca327d4b07fb5cdbecff38d3a0fdbdf7200844

9Y4FGR
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The video file was loaded into Amped Five forensic software for processing and clarification. Once 
VideoMaterial.mov was loaded into the Amped Five software application, file detail information was 
displayed, and the video was able to be played so that the condition of the video and its overall quality 
could be assessed. The HASH feature was employed to confirm the SHA-256 hash generated previously 
by the Teracopy hashing application (report detail below). Next, the FILE INFO feature was used to 
generate additional file detail from multiple reporting applications: MediaInfo, FFProbe, and Exif View. 
The following information was collected: frame rate, pixel dimension, bit frame, number of frames in the 
video file, and if an audio track was present (see report details below). Preparing the image processing 
required it be rotated 180 degrees (see report details below). The test required the license plate in the 
video to have the perspective corrected to reflect the camera being parallel to the plate and to the 
license plate's 2:1 width to height ratio: The CORRECT PERSPECTIVE filter was used addressed both 
issues, correcting the perspective and sizing the plate to 172 x 86 pixels (see report details below). The 
video was stabilized with the LOCAL STABLIZATION filter and allowing the area directly around the 
license plate to be tracked by the stabilization filter (see report details below). The image around the 
license plate was cropped to 640 x 480 pixel using the CROP filter (see report details below). The 
license plate was clarified using an UNSHARPEN MASK filter to increase the detail of the license plate 
characters and the filter was configured to track just the area of the license plate (see report details 
below). The overlay of the frame count was done with the ADD TEXT feature which had a preinstalled 
setting for that task (see report details below). The VIDEO WRITER feature was used to generate a MP4 
container and h.264 encoded visually lossless video of the processed video as specified in the 
enhancement instructions (see report details below). The SNAPSHOT tool on the video timeline was used 
to create three (3) still images in BMP format that represent the clearest images of the license plate from 
the processed video. Report Details: Summary: Filename: ../Q1/Extracted/24-5581 
Video/VideoMaterial.MOV. File Size (bytes): 10622916. Format: mov,mp4,m4a,3gp,3g2,mj2. Codec: 
h264. Width (pixels): 1920. Height (pixels): 1080. Fps: 29.9700. Length (frames): 159. Duration (time): 
00:00:05.305. Output File Details: Filename: 24-5581_[participant code]_VideoMaterial.mp4. File 
Size (bytes): 10702075. Format: mov,mp4,m4a,3gp,3g2,mj2. Codec: h264. Width (pixels): 640. 
Height (pixels): 480. Fps: 29.9700. Length (frames): 159. Duration (time): 00:00:05.305. Summary: 
VideoMaterial Video Loader: Loads a video from file. Parameters: File: Q1/Extracted/24-5581 
Video/VideoMaterial.MOV. Video Engine: FFMS. Color Range: Limited. Audio Stream: None. Original 
File: Concatenate File List: Additional Information: Video Streams: 1. Audio Streams: 0. Subtitle 
Streams: 0. Hash Code Calculates the input file hash code to check data integrity when loading the 
project. Supports several hashing algorithms. Details: Parameters: Mode: SHA256 Hash Codes: 0: 
84a361708461d90dc418e56be6b7e045799564f9210b926a97e16903785553f5. File Info: Saves 
file information and EXIF metadata on the report. Details: The File Info filter extracts the metadata 
displayed by the media interrogation tool EXIF View and prints all the available information in the report. 
Parameters: This filter has no parameters. Additional Information: Info: General Info: File Name: 
VideoMaterial.MOV File Path: D:\ProTest_2024_MW_Video\Q1\Extracted\24-5581 
Video\VideoMaterial.MOV. File Size (bytes): 10622916. Type: Video. Format: 
mov,mp4,m4a,3gp,3g2,mj2. Color Channels: 3. Width (pixels): 1920. Height (pixels): 1080. Codec: 
h264. Fps: 29.9700. Length (frames): 159. Duration (time): 00:00:05.305. SAR (Storage Aspect Ratio): 
16:9 (1.778). SAR (Sample Aspect Ratio): Undefined (0:1) (0.000). DAR (Display Aspect Ratio): 16:9 
(1.778). PAR (Pixel Aspect Ratio): 1:1 (1.000). Color Range: Limited. Total Streams: 1. Video Streams: 
1. Audio Streams: 0. Subtitles Streams: 0. Rotate: Rotates the image. Parameters: Angle: 180 Rotation 
angle. Resize Image to Fit: true. Interpolation: Bicubic Background Color: #000000. Correct 
Perspective: Corrects the perspective of a plane of interest within the image (image rectification). 
Parameters: Source Points: 1405, 829 - 1437, 854 - 1436, 914 - 1404, 886. Quadrilateral to 
transform into a rectangle. Target Selection: x: 1404, y: 829, w: 172, h: 86. Target rectangle to map 
the source points to. Local Stabilization: Stabilizes a shaking video by keeping the current selection 
steady. The object of interest must be present in all frames. Supports different stabilization modes. 
Parameters: Background Color: #000000. Selection: Static Tracking. Reference Selection(s) 0: x: 1401, 
y: 822, w: 180, h: 102. Crop: Crops a region of interest of the image. Parameters: Selection: x: 1159, 
y: 599, w: 640, h: 480. Unsharp Masking: Sharpens the image using an unsharp masking filter. 
Parameters: Strength: 0.5700. Size: 79. Threshold: 0. Mode: Intensity. Selection: Static Tracking. 

A8X93Q
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Reference Selection(s). 158: x: 242, y: 250, w: 159, h: 56. Add Text: Adds text to the image. Supports 
several macros to dynamically change the content of the text. Font, color, size and position can be 
customized. Parameters: Text: FRAME: $POSITIONFRAMES. The text to add to the image. Text Style: 
arial 14 windows-1252, #FFFFFF, Left, Bottom. Text appearance and layout. Background Color: 
#000000. The color used to paint the rectangle underneath the text, if required. Background Shape: 
None. The shape of the colored background, if activated. Start Page Number: 1. The first page for the 
Page Number macro. Selection: Whole Image. The selection where the filter is applied to. It may be the 
whole image, a static region, or a region containing a tracked object of interest. Video Writer: Writes the 
current video to a file. Parameters: File: Processed/24-5581_[participant code]_VideoMaterial.mp4. 
Container and Video Codec: mp4 - H264. Audio Codec: None. Frame rate: 29.9700 Quality: Visually 
Lossless. HW Acceleration: None. Additional Information: Video Streams: 1. Number of video streams in 
the video Audio Streams: 0. Number of audio streams in the video Subtitle Streams: 0. Number of 
subtitle streams in the video. [Participant submitted data in a format that could not be reproduced in this 
report].

using Axon Investigate ver. 4.1.1, (researched on how to use GIMP and Blender 4.2, but did use in the 
results of this test) selected the workflow module; 1st filter I used was Lens correction - tried different 
ranges until I settled on one. Tried rotate filter so see if I could get a better view of license plate. I used 
the Level Adjustment filter to see if I could get the number on the license plate to appear clearer. 
Selected the stablize filter to slow down the shakiness

A9N7GP

The video was reviewed using Axon Investigate v. 3.1.0 to evaluate the video. In order to complete the 
requested steps for the test, the video was processed in Amped Five, build date 20221208, revision 
26914. The video of interest was imported using the video loader. This resulted in the video being 
imported upside down. The video was rotated 180 degrees. The Correct Perspective filter was applied to 
the area of the license plate and the output selection area was stretched on the horizontal axis to 
approximate the aspect ratio of a license plate. The interpolation was set to Nearest Neighbor. 
Perspective Stabilization was used to stabilize the movement of the license plate caused by the camera 
movement. The tracking method was set to Hybrid Tracking and the interpolation was set to Nearest 
Neighbor. The video was cropped to the area of the license plate. A levels adjustment was applied to 
the cropped video with the highlights set to 144, midtones 75 and shadows 6. The video was resized 2x 
using Nearest Neighbor interpolation. Once this was completed, Add Text was used to apply the frame 
number to each frame of the video starting at 0. The video was exported as an MP4 video file using 
H.264 video compression. Still images from Frame 0 and Frame 150 were exported from the video and 
saved as PNG files.

ACNHCP

Tool: Amped FIVE, Build date: 20240711 Revision: 34212. Methods used: Once the file was loaded in 
Amped Five the following filters were used; rotate, correct perspective, perspective stabilization, crop, 
levels, and unsharp masking. The enhanced video file was exported as an mp4 with the h264 codec. 
Refer to Amped FIVE report uploaded for more details.

AV4RDP

Amped FIVE revision 33279. - Video Loader, - Rotate – 180 degrees, - Correct Perspective, – Width 
100, Height 50, - Local Stabilisation – Dynamic tracking (X:1321, Y:770, W:176, H:126), - Perspective 
Stabilisation, – Perspective, Static Tracking, Bicubic, - Crop – X:1100, Y:650, W:640, H:360, - Resize – 
Zoom of 3, Bicubic interpolation, W:1920 H:1080, - Sparse Selector - Frames 0, 154, 155 - Frame 
Averaging, - Contrast Brightness – Contrast: 50, Brightness: 35, - Picture in picture

B23TTA
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A. Conduct a perspective correction of the designated vehicle's license plate (that is, process the video 
such that it closely resembles the perspective of the license plate as if the camera lens was parallel with 
it). The license plate has a width-to-height ratio of 2:1. Actions taken: File loaded into Amped FIVE 
version 33279. Video appears upside down. 1. Edit > Rotate > +180.00 2. Edit > Correct Perspective 
> selected the area from top left hand corner. 3. Used the refinement, under the correct perspective tab, 
re-selected the four corners of the reg plate and applied. B. Conduct a video stabilization of the 
perspective-corrected video. Actions taken: 1. Stabilization > Local Stabilization > Whole Image. C. 
Crop around the license plate. The size of your cropped area is your choice, but the entire license plate 
must be visible in the cropped version. Actions taken: 1. Edit> Crop > Apply> Dimensions: 362/ 214. 
D. Conduct a video enhancement of the license plate in the cropped version. Actions taken: 1. Adjust > 
Levels > highlighted to 161, shadow set to 18, midtones set at 89. E. Overlay the frame numbers as text 
near one of the corners of the video. Start with the first video frame as frame 0. Actions taken: 1. 
Presentation > Add Text > Selected $POSTIONFRAMES - selected font/size, left top position. Font 
Colour - White. F. Export the final product as an MP4 file, with H.264 video encoding. Actions taken: 1. 
Write > Video Writer - choose where to save/named file > container .mp4 - video codec H264 > 
apply. G. Select and export between one and three frames of your choice (as PNG, BMP, or TIFF image 
files) which you believe represent the clearest images of the license plate. Actions taken: 1. Write > 
Image Writer - choose where to save/named files > container PNG > selected Frame 3 and Frame 
155 > apply

B3JPKA

Amped Five v.13609, Adobe Photoshop v.25.0.0, Adobe Premiere v.24.0.0 rotate, correct perspective, 
unsharp masking, motion debluring, local stabilization, crop

B7J2GA

Visual examination and analysis by using forensic tool Amped FIVE – Forensic Image and Video 
Enhancement. This is the summary of working method or filter used: 1. Video Loader: Loads a video 
from file. 2. Hash Code: Calculates the input file hash code to check data integrity when loading the 
project. Supports several hashing algorithms. 3. Rotate: Rotates the image. 4. Correct Perspective: 
Corrects the perspective of a plane of interest within the image (image rectification). 5. Aspect Ratio: 
Corrects the aspect ratio of a video. 6. Range Selector: Selects a range of frames in a video. Supports 
the trimming of the original video stream with no transcoding. 7. Local Stabilization: Stabilizes a shaking 
video by keeping the current selection steady. The object of interest must be present in all frames. 
Supports different stabilization modes. 8. Crop: Crops a region of interest of the image. 9. Smart Adjust: 
Improves the local contrast of an image minimizing halo artifacts and the clipping of highlights. 10. Add 
Text: Adds text to the image. Supports several macros to dynamically change the content of the text. (use 
$POSITIONFRAMES to add frame at the text) 11. Resize: Resizes the image.

BJH3TB
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Task A: Software Utilized: - Amped FIVE Revision 29850 Method: To complete the Task A, the following 
method applies using Amped Five Revision 29850 1. Load Video File VideoMaterial.MOV. Choose 
Filter Group Edit -> Filter name Correct Perspective, this following parameter applied :- Source Points: 
1406, 829 - 1445, 855 - 1441, 919 - 1400, 890 Quadrilateral to transform into a rectangle. Target 
Selection: x: 867, y: 481, w: 433, h: 220 Target rectangle to map the source points to. 2. To change 
the Aspect Ratio to 2/1, Choose Filter Group Edit -> Filter Name Aspect Ratio and this following 
parameter applied :- Output Aspect Ratio: 2/1 The Aspect Ratio of the output image, expressed as a 
fractional number. Mode: Retain Height The dimension to keep fixed. Interpolation: Bicubic Interpolation 
algorithm used when the image is resized. Task B: Software Utilized: - Amped FIVE Revision 29850 
Method: To complete the Task B, the following method applies using Amped Five Revision 29850 1. 
Choose Filter Group Stabilization -> Filter Name Global Stabilization and this following parameter 
applied :- Maximum Shift: 199 The maximum horizontal and vertical shifts (in pixels) to correct. Frames: 
159 The number of frames to be computed for the stabilization. Background Color: #000000 Color 
used to fill the area outside the original image. Task C: Software Utilized: - Amped FIVE Revision 29850 
Method: To complete the Task C, the following method applies using Amped Five Revision 29850 1. 
Choose Filter Group Edit -> Filter Name Crop and this following parameter applied :- - Selection: x: 
806, y: 469, w: 695, h: 595.  Task D: Software Utilized: - Amped FIVE Revision 29850 Method: To 
complete the Task D, the following method applies using Amped Five Revision 29850 1. Choose Filter 
Group Adjust -> Filter Name White Balance and this following parameter applied:- • Color Space: 
RGB The color space in which the processing is performed. • Exposure Correction (EV): 1.5000 Adjusts 
the overall brightness of the image. • Selection: Whole Image The selection where the filter is applied 
to. It may be the whole image, a static region, or a region containing a tracked object of interest. 2. 
Choose Filter Group Adjust -> Filter Name Temperal Tint and this following parameter applied:- • 
Exposure Correction (EV): 0.1000 Adjusts the overall brightness of the image. • Color Temperature 
(Kelvin): 8353 Color temperature used for Temperature Tint correction. Low = orange, 6500 = white, 
high = blue. • Tint Correction ([delta]uv percent): 3 Color tint used for Temperature Tint correction. 
Negative = purple, positive = green. • Mode: Map Selected Color to White The way the filter processes 
the image. 3. Choose Filter Group Adjust -> Filter Name Automatic Color Equalization and this 
following parameter applied:- • Method: Discrete Fourier Transform (DFT) Filtering method used in the 
piecewise linear approximation. • Strength: 7.4000 Strength of the filter. Higher values produce a 
stronger effect. Task E: Software Utilized: - Amped FIVE Revision 29850 Method: To complete the Task 
E, the following method applies using Amped Five Revision 29850 1. Choose Filter Group Presentation 
-> Filter Name Add Text and this following parameter applied:- Text: $POSITIONFRAMES The text to 
add to the image. Text Style: bold century 18 windows-1252, #FFFFFF, Left, Top Text appearance and 
layout. Background Color: #000000 The color used to paint the rectangle underneath the text, if 
required. Background Shape: Text The shape of the colored background, if activated. Date Format: %Y-
%m-%d %a: Abbreviated weekday name %A: Full weekday name %b: Abbreviated month name %B: Full 
month name %d: Day of month as decimal number (01 - 31) %m: Month as decimal number (01 - 12) 
%U: Week of year as decimal number, with Sunday as first day of week (00 - 53) %w: Weekday as 
decimal number (0 - 6; Sunday is 0) %W: Week of year as decimal number, with Monday as first day of 
week (00 - 53) %x: Date representation for current locale %y: Year without century, as decimal number 
(00 - 99) %Y: Year with century, as decimal number %z, %Z: Either the time zone name or time zone 
abbreviation, depending on registry settings; no characters if time zone is unknown Time Format: %H:
%M:%S.%l %H: Hour in 24-hour format (00 - 23) %I: Hour in 12-hour format (01 - 12) %l: Milliseconds 
with leading zeros (000 - 999) %M: Minute as decimal number (00 - 59) %p: Current locale's 
A.M./P.M. indicator for 12-hour clock %S: Second as decimal number (00 - 59) %X: Time 
representation for current locale Start Page Number: 0 The first page for the Page Number macro. 
Selection: Whole Image The selection where the filter is applied to. It may be the whole image, a static 
region, or a region containing a tracked object of interest. Task F: Software Utilized: - Amped FIVE 
Revision 29850 Method: To complete the Task E, the following method applies using Amped Five 
Revision 29850 1. Choose Filter Group Write -> Filter Name Video Writer and this following parameter 
applied:- • File: [Name] TEST NO 24-5581-VideoMaterial.mp4 Path of the file to save. • Container 
and Video Codec: mp4 - H264 Container and codec used to store the media stream(s). • Audio 
Codec: None Codec used to write the audio stream. • Frame rate: 30 Frame rate (in frames per 

CACG79

( 33 )Printed:  09-October-2024 Copyright ©2024 CTS, Inc



Forensic Video Analysis Test 24-5581

TABLE 2
 Question 2- 1 : Enhanced Video Examination 

ResponseWebCode
second) of the output video. Note that some video formats support only a limited set of frame rates, and 
the frame rate may influence some properties of the output video (e.g. the GOP size) for some codecs. • 
Quality: Default If a codec with quality control has been selected, the following options can be selected: 
Default: Uses a Constant Rate Factor of 18 High: Uses a Constant Rate Factor of 12 Visually Lossless: 
Uses a Constant Rate Factor of 1 • HW Acceleration: None Enables encoding acceleration of the 
on-board Graphic Processing Unit. Acceleration will be tested when the filter is applied. Additional 
Information: • Video Streams: 1 Number of video streams in the video • Audio Streams: 0 Number of 
audio streams in the video • Subtitle Streams: 0 Number of subtitle streams in the video. [Participant 
submitted data in a format that could not be reproduced in this report].

Methods: 1. Technical Overview of Digital Video Files. 2. Best Practices for Digital Forensic Video 
Analysis. 3. Fundamentals of Resizing Imagery and Considerations for Legal Proceedings. 4. Technical 
specification for forensic image processing SF/T 0152—2023. Tools: Cognitech Video Investigator 
V7.0, Mingjing video&image enhancement system V3.22,Adobe Premiere Pro 2022,Adobe Photoshop 
2024. Settings: A.Extract video frames. B. Analyze all video frames and find that there are enough clear 
frames available for inspection. C. Exclude frames that are too blurry and select the clearest 14 frames 
as available frames, including frames 1, 4, 15, 140, 142, 144, 145, 148, 149, 150, 152, 154, 155, 
and 156. D. Align and stabilize the selected frames. E. Crop around the license plate. F. license plate 
images are stretched and deformed in a width-to-height ratio of 2: 1.Edge and corner positioning 
parameters: Upper left:-275.0; 76.7. Upper right: 456.7; -71.7. Bottom left: -230.0; 394.2. Bottom 
right: 479.2; 210.8. G. frame averaging. H. Adjust the brightness and contrast of the processing results, 
and sharpen the edges

CC4FK8

1. Used corrective perspective around the license plate. 2. Applied local stabilization using the license 
plate as the planar object. 3. Cropped around the plate. 4. Applied unsharp mask 5. Applied levels 
adjustment 6. Used Add Text filter using $POSITIONFRAMES macro to label each frame # starting with 
0. 7. Exported out as MP4 with h264 encoding. 8. Selected Frames 149, 155, and 158 to export out as 
single TIF images. Technique 2 1. Scrubbed through video and removed frames with strong levels of 
blur 2. Applied perspective stabilization around the license plate. 3. Frame averaged. 4. Levels 
adjustment 5. Sharpening 6. Correct perspective 7. Exported out as TIF image.

CJ33AL

Video rotated 180 degrees. Perspective correction used to correct license plate. Local stabilization 
applied using license plate as area of interest. Video cropped to area of interest. Smart Adjust (Mode: 
Equalization, Strength: 8, Edge Threshold: 2). Smart Resize (2x, Warped Distance). Annotation added 
showing position in frames. 2 .tif images exported. 1 video file exported (.mp4/h264/visually lossless)

CRD6VM

My first step was to use Adobe Photoshop version 25.6.0 to align the frames of the video (stabilization). 
To do that I needed to extract the frames of the video and import them as images. FFMPEG version 
4.4.1 was used to do this. The command ffmpeg -i VideoMaterial.MOV frame-%03d.png was used to 
export all of the frames of the video as PNG image files. Because the license plate was only ever shown 
in the lower right quadrant of the video, I also used FFMPEG to crop the frames before importing them 
into Photoshop using the batch file shown below. This cropping will reduce the processing demand for 
frame alignment (excluding a large amount of data irrelevant to achieving stabilization of the license 
plate). Next I imported these cropped PNG images into Photoshop as a “stack”. Once the frames were 
loaded as layers, all layers were selected and Auto-Align Layers was applied. Once Photoshop 
completed processing, the frames (layers) were aligned. A sample frame is shown below, illustrating how 
stabilization is achieved. Finally, the layers were exported again as frames to be loaded into Amped Five 
(build 31095). Trim Layers must be deselected. Finally, Amped Five reloads this cropped and aligned 
frames as a “sequence”. The entire Amped Five “chain” (process) is reproduced below with annotations. 
This shows every step taken, in order, along with the relevant settings in each case. The Amped Five 
chain produced a MP4 video titled result.mp4. I exported frame zero, frame 150 and frame 158 as the 
clearest frames (two of which also happen to be based on iframe data). These notes should enable 
someone to duplicate the result achieved here.

DBZD7M

Amped FIVEDJW977
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Used Amped FIVE for both the video and stills enhancement when ever files were copied / transferred 
Tera copy was used to ensure that file integrity was maintained. under Ampred FIVE I used the following 
filters to enhance the video. Video Loader: Loads a video from file. Rotate: Rotates the image. Local 
Stabilization: Stabilizes a shaking video by keeping the current selection steady. The object of interest 
must be present in all frames. Supports different stabilization modes. Correct Perspective: Corrects the 
perspective of a plane of interest within the image (image rectification). Aspect Ratio: Corrects the aspect 
ratio of a video. Crop: Crops a region of interest of the image. Local Stabilization: Stabilizes a shaking 
video by keeping the current selection steady. The object of interest must be present in all frames. 
Supports different stabilization modes. Unsharp Masking: Sharpens the image using an unsharp masking 
filter. Levels: Adjusts intensity and color levels. Resize: Resizes the image. Annotate: Draws annotations 
over the image. Video Writer: Writes the current video to a file. For the still image enhancement I used 
the following Ampd FIVE filters Video Loader: Loads a video from file. Rotate: Rotates the image. Local 
Stabilization: Stabilizes a shaking video by keeping the current selection steady. The object of interest 
must be present in all frames. Supports different stabilization modes. Correct Perspective: Corrects the 
perspective of a plane of interest within the image (image rectification). Aspect Ratio: Corrects the aspect 
ratio of a video. Crop: Crops a region of interest of the image. Local Stabilization: Stabilizes a shaking 
video by keeping the current selection steady. The object of interest must be present in all frames. 
Supports different stabilization modes. Unsharp Masking: Sharpens the image using an unsharp masking 
filter. Levels: Adjusts intensity and color levels. Resize: Resizes the image. Image Writer: Writes the 
current image to a new file. For a more indepth look at settings of the filters i have used i included a 
Amped Five report with each product. [Report was not included here.]

EDKJ6A

1. Download files and verify hash values. 2. Extract working copy of file. 3. Adobe Premiere Pro (version 
24.5.0) used to crop the video and apply Warp Stabilizer effect to video (No motion, 
position/scale/rotation, stabilize only, detailed analysis). 4. Export processed video as a sequence of 
bmp still images (159 images). 5. Adobe Photoshop (version 25.9.1) used to apply Perspective Warp to 
images (pinned near each of the four corners of the license plate, on the same plane, undistorted and 
adjusted to approximate 2:1 ratio). 6. Save processed images as tif still images (159 images). 7. Adobe 
Premiere Pro used to compose video from still images on a 1920x1080 canvas, crop video, and add 
text annotation near bottom right corner of video frame to indicate the frame number for each image 
throughout the duration of the video. 8. Export video as an .mp4 video using H.264 encoding as 
requested Note: The above sequence and methods are accepted under our Standard Operating 
Procedures. It was not indicated that exact frame timing was of concern in the final video, so the video to 
still image to video process is acceptable in this scenario. All intermediate file saving was completed 
using lossless formats to ensure that image quality was maintained throughout the process. 9. One 
frame (annotated frame number 150, I-frame in original video) was exported from the processed video. 
10. Axon Investigate (version 4.1.1) was used to mark and export one frame (frame number 150, 
I-frame in original video) and a sequence of still images (Frames 140-156). 11. The individual frame 
(150) was processed using Adobe Photoshop to apply levels adjustments, transform the image (stretched 
horizontally), apply unsharp mask adjustments, and enlarge 300% (bicubic). 12. The still image 
sequence (140-156) were processed using Adobe Photoshop to frame average, transform the image 
(stretched horizontally), and apply levels and unsharp mask adjustments. 13. Results of processing 
include one processed video file, one still image from the processed video file, and two processed still 
images from the original video file

FKZPEL

Utilized Amped FIVE software for clarification purposes. Video Loader, File Info, Hash Code, Rotate, 
Correct Perspective, Global Stabilization, Crop, White Balance, Levels, Automatic Color Equalization, 
Add Text, Video Writer - Writes the current video to a file. Image Writer - Writes the current image to a 
new file. Image Writer - Writes the current image to a new file. Image Writer - Writes the current image 
to a new file.

GJLF2E
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- Confirm Hash of downloaded .zip file from CTS. - Transfer to workstation and confirm hash again. - 
Extract .mov file from .zip file and hash, create working copy and confirm hash. - Ingest into Amped FIVE 
forensic analysis software. Hardware/Software Specs: Software version info: Build date: 20240711 
Revision: 34212. Platform: Operating System: Microsoft Windows, 64 bit CPU Model: Intel(R) Xeon(R) 
Silver 4114 CPU @ 2.20GHz. - Interrogate media file, and answer questions 1.1 to 1.6. - Visual review 
of video. Note: at the end of the video there are more consecutive stable frames than in other sections 
of the video. - Perform processing according to test instructions. Three different processes were 
performed: 1. Enhancement 1: - Rotate: Multiple of 90 degree angle simply transposes the original pixel 
values. Parameters: Angle: 180 Rotation angle. Interpolation: Nearest. Background Color: #000000. - 
Correct Perspective: correct license plate area to become parallel to the lens with 2:1 aspect ratio. 
Parameters: Source Points: 1383, 896 - 1416, 921 - 1415, 984 - 1382, 954 Quadrilateral to 
transform into a rectangle. Target Selection: x: 1295, y: 896, w: 178, h: 89 Target rectangle to map the 
source points to. - Local Stabilization: stabilize the shaky license plate area by shifting the frames 
horizontally and vertically. Parameters: Background Color: #000000 Color used to fill the area outside 
the original image. Selection: Static Tracking Reference Selection(s) 0: x: 1372, y: 716, w: 246,h 202. - 
Crop: crop the image to contain the license plate area only. Parameters: Selection: x: 1376, y: 749, w: 
242, h 145. - Levels: adjust intensity and color levels to contain the full range of available values. 
Parameters: Value: 224, 112, 0 Highlights, Midtones and Shadows settings used to map the pixel values 
of the grayscale converted image. Red: 255, 127, 0 Highlights, Midtones and Shadows settings used to 
map the pixel values of the red channel of image. Green: 255, 127, 0 Highlights, Midtones and 
Shadows settings used to map the pixel values of the green channel of image. Blue: 255, 127, 0 
Highlights, Midtones and Shadows settings used to map the pixel values of the blue channel of image. 
Selection: Whole Image. - Contrast: increases the difference between lighter and darker areas. 
Parameters: Contrast: 20 Extends the intensity difference among pixels (linear gain). Selection: Whole 
Image. - Unsharp Mask: sharpen. Parameters: Strength: 1 Intensity of the sharpening effect: larger 
values provide increasing amounts of sharpening. Size: 15 Length, in pixels, of the side of the square 
filter window. Threshold: 0 Selection: Whole Image. - Range selector: selecting only a specific range of 
frames in the video. Parameters: First Frame: 140 Last Frame: 157. - Super Resolution: obtain a single 
higher resolution image by merging pixel information of all frames, Parameters: Zoom: 2 Zoom factor 
for the output image. Iterations: 10 Number of deblurring steps. Selection: x: 0, y: 0, w: 0, h: 0 Region 
of the image to optimize. - Annotate: draw information over the bottom of the image for output. 
Parameters: Annotation Tool: Text ("Super Resolution of enhanced Frs 140-157")Colors: Text #FFFFFF• 
, Background #000080• , Border None (Center: [239, 266], Rotation: 0°, Width: 477px, Height: 50px 
- Image Writer: write the current image to a new file Parameters: File: . . . 
/VideoMaterial_A5_Enh1_Frs140to157_SupRes.tif 2. Enhancement 2: - Rotate: Multiple of 90 degree 
angle simply transposes the original pixel values. Parameters: Angle: 180 Rotation angle. Interpolation: 
Nearest. Background Color: #000000 - Correct Perspective: correct license plate area to become 
parallel to the lens with 2:1 aspect ratio Parameters: Source Points: 1383, 896 - 1416, 921 - 1415, 
984 - 1382, 954 Quadrilateral to transform into a rectangle. Target Selection: x: 1295, y: 896, w: 
178, h: 89 Target rectangle to map the source points to. - Local Stabilization: stabilize the shaky license 
plate area by shifting the frames horizontally and vertically. Parameters: Background Color: #000000 
Selection: Static Tracking Reference Selection(s) 0: x: 1372, y: 716, w: 246, h: 202 - Crop: crop the 
image to contain the license plate area only Parameters: Selection: x: 1376, y: 749, w: 242, h: 145 - 
Resize: enlarge the image, Parameters: Size: 484, 290 Size of output image in pixels. Interpolation: 
Nearest - Levels: adjust intensity and color levels to contain the full range of available values 
Parameters: Value: 224, 112, 0 Highlights, Midtones and Shadows settings used to map the pixel values 
of the grayscale converted image. Red: 255, 127, 0 Highlights, Midtones and Shadows settings used to 
map the pixel values of the red channel of image. Green: 255, 127, 0 Highlights, Midtones and 
Shadows settings used to map the pixel values of the green channel of image. Blue: 255, 127, 0 
Highlights, Midtones and Shadows settings used to map the pixel values of the blue channel of image. 
Selection: Whole Image - Contrast: increases the difference between lighter and darker areas 
Parameters: Contrast: 20 Extends the intensity difference among pixels (linear gain). Selection: Whole 
Image - Unsharp Mask: sharpen Parameters: Strength: 1 Intensity of the sharpening effect: larger values 
provide increasing amounts of sharpening. Size: 15 Length, in pixels, of the side of the square filter 

GWBEV3
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window. Threshold: 0 Selection: Whole Image - Range selector: selecting only a specific range of frames 
in the video Parameters: First Frame: 140. Last Frame: 157 - Frame Averaging: reduce noise by 
creating a single image which is the average of all frames - Annotate: draw information over the bottom 
of the image for output Parameters: Annotation Tool: Text ("Frame Average of enhanced Frs 140-157") 
Colors: Text #FFFFFF• , Background #000080• , Border None (Center: [242, 266], Rotation: 0°, 
Width: 484px, Height: 50px) - Image Writer: write the current image to a new file Parameters: File: . . . 
/VideoMaterial_A5_Enh2_Frs140to157_FrAvg.tif 3. Enhancement 3: - Rotate: Multiple of 90 degree 
angle simply transposes the original pixel values. Parameters: Angle: 180 Rotation angle. Interpolation: 
Nearest. Background Color: #000000 - Correct Perspective: correct license plate area to become 
parallel to the lens with 2:1 aspect ratio Parameters: Source Points: 1383, 896 - 1416, 921 - 1415, 
984 - 1382, 954 Quadrilateral to transform into a rectangle. Target Selection: x: 1295, y: 896, w: 
178, h: 89 Target rectangle to map the source points to. - Local Stabilization: stabilize the shaky license 
plate area by shifting the frames horizontally and vertically. Parameters: Background Color: #000000 
Selection: Static Tracking Reference Selection(s) 0: x: 1372, y: 716, w: 246, h: 202 - Crop: crop the 
image to contain the license plate area only Parameters: Selection: x: 1376, y: 749, w: 242, h: 145 - 
Resize: enlarge the image Parameters: Size: 968, 580 Size of output image in pixels. Interpolation: 
Nearest. - Levels: adjust intensity and color levels to contain the full range of available values 
Parameters: Value: 224, 112, 0 Highlights, Midtones and Shadows settings used to map the pixel values 
of the grayscale converted image. Red: 255, 127, 0 Highlights, Midtones and Shadows settings used to 
map the pixel values of the red channel of image. Green: 255, 127, 0 Highlights, Midtones and 
Shadows settings used to map the pixel values of the green channel of image. Blue: 255, 127, 0 
Highlights, Midtones and Shadows settings used to map the pixel values of the blue channel of image. 
Selection: Whole Image - Contrast: increases the difference between lighter and darker areas 
Parameters: Contrast: 50 Extends the intensity difference among pixels (linear gain). Selection: Whole 
Image - Unsharp Mask: sharpen Parameters: Strength: 1 Intensity of the sharpening effect: larger values 
provide increasing amounts of sharpening. Size: 15 Length, in pixels, of the side of the square filter 
window. Threshold: 0 Selection: Whole Image - Annotate: draw information over the bottom right of the 
image for output Parameters: Annotation Tool: Text ("Original Frame Number: 
$ORIGINALPOSITIONFRAMES")Colors: Text #FFFFFF• , Background #000080• , Border None from 
frame 0 (Center: [726, 555], Rotation: 0°, Width: 484px, Height: 50px) to frame 158 (Center: [688, 
555], Rotation: 0°, Width: 560px, Height: 50px) - Video Writer: write current video to a file Parameters: 
File: . . . /VideoMaterial_A5_Enh3.mp4 Container and Video Codec: mp4 - H264 Audio Codec: None 
Frame rate: 29.9700 Quality: Visually Lossless - Image Writer: write an image of the current first video 
frame to a new file Parameters: File: . . . /VideoMaterial_A5_Enh3_iFr000.tif. [Participant submitted 
data in a format that could not be reproduced in this report].

Processing done in Amped Five. A corrective perspective was made to select the area of the license plate 
more rectangular. The video was then rotated -90 bicubic so it would not appear upside down. Local 
stabilization using static tracking was applied to reduce camera shakiness. A crop was applied to just 
show around the license plate area. A grayscale conversion was applied to remove color noise. The 
levels was applied to adjust contrast. The unsharp mask was applied to increase sharpness. Annotate 
was used to display frame numbers. Exported images saved as TIFF. The Amped Five report was 
included to show exact settings. [Report was not included here.]

HNZDA2

Using Amped FIVE. Video was rotated 180 degrees. Local Stabilization applied. Perspective correction to 
correct for distortion in plate. Additional Stabilization applied. Cropped to area of plate. Adjusted 
contrast and brightness using Smart Adjust. Resized the video to 2X using Smart resize. Added frame 
count to each frame starting at 0, ending at 158. Exported H.264 MP4 file for distribution. Exported 
Frame "0" as Tiff

HVA2KE
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Transferred 'VideoMaterial' video file from O'Drive to Edit 4 via writeblocked Codec 4. Extracted file 
contents (mov video). Imported file into Amped via 'Video Loader'. Per OIC request created two pieces of 
material: video with frame numbers and still image (both enhanced). Video Enhancement – AMPED FIVE 
- Video Loader (colour range full; - Rotate; - Correct Perspective; - Perspective Stabilisation (Local 
Stabilisation of planar objects, capable of tracking perspective transformations). - Cropped; - Frame 
Numbers added as text; - Levels Filter (intensity and colour levels); - Export: MP4, H264, Visually 
Lossless via video writer. Image Enhancement – AMPED FIVE: - Video Loader (colour range full), - 
Rotate, - Correct Perspective, - Perspective Stabilisation (Local Stabilisation of planar objects, capable of 
tracking perspective transformations). – Cropped, - Range Selector (For frames), - Frame Averaging, - 
Levels Filter (intensity and colour levels), - Export: PNG via Image WriterVideo. Full Amped Report saved 
in casework. Exported video (MP4, H264, Visually Lossless) and image (PNG). Video and Image MD5 
hashed separately and each burnt onto separate DATA CDs using Epson TDM. Verified hashes. Video 
file exhibited as JS0188-1 on 08/08/24 15:00. Image file exhibited as JS0188-2 on 08/08/24 at 
15:00. Digital copy of work provided to proficiency testing company, alongside questionnaire responses 
and Amped enhancement report. Enhanced video not converted through Adobe Premiere - as not 
required to be uploaded to DAMS. Questionnaire responses completed on word document. JS0188/1 - 
Processed video from clip 'Video Material.MOV' JS0188/2 - Processed still image from clip 'Video 
Material.MOV'

J8J2UD

1. Rotate the image by 180 degrees using the Rotate filter. 2. Set the least shaken interval of the video 
using the Range Selector. 3. Stabilize the shake by specifying only the license plate number portion using 
the Perspective Stabilization filter. 4. Correct the perspective of the tilted license plate number using the 
Correct Perspective filter. 5. Improve the image quality by using Curve, Level and Unsharp Mask, etc. 
filters. 6. Mark the frame in the upper right corner using the Text tool of Amped Five. 7. Verify and save 
the results using the Frame Average filter. 8. Unenable the Frame Average filter and render the final 
result of the video as MP4(H.264 Codec) Container.

JZNYT2

Zip File containing enhanced video and images of license plate (MD5 hash value: 
55da4acfe8c4289d6f2e3ffccf7a5331). Methods/Tools: Amped FIVE Revision: 33279 As per the "Part 
2:Video Enhancement Instructions, Task D: Conduct a video enhancement of the license plate in the 
cropped version" The settings for the video enhancement of the license plate in the cropped version 
using Amped FIVE Revision: 33279 are as follows: Resize Parameters: Size: 334, 220 (Width, Height) 
Size of output image in pixels. Zoom: 2 Interpolation: Bicubic Interpolation algorithm used when the 
image is resized. Unsharp Masking Parameters: Strength: 0.5000 Size: 99 Threshold: 0 Mode: Intensity 
Selection: Whole Image Contrast Brightness Parameters: Contrast: 25 Brightness: 17 Mode: Linear 
Selection: Whole Image Levels Parameters: Value: (Highlights: 234, Midtones: 104, Shadows: 0) Red: 
(Highlights: 255, Midtones: 127, Shadows: 0) Green: (Highlights: 255, Midtones: 127, Shadows: 0) 
Blue: (Highlights: 255, Midtones: 127, Shadows: 0) Selection: Whole Image [Participant submitted data 
in a format that could not be reproduced in this report].

KV8Q63

Used AmpedFive for the following: Rotate 180 degrees, correct perspective, stabilization-local 
stabilization with dynamic tracking, crop, adjust levels, unsharp mask, presentation-annotate for 
applying frame numbers, writer for video and still frames

LNKKHF
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-The video file VideoMaterial.MOV was opened in Cognitech Video Investigator Release 64 build 7.0. 
-Video was rotated 180 degrees with Mirror Image. Position 4 Glyphs on the 4 corner of the plate and 
repositioned on each 159 frames. -Used the Rectification function (adjusted the video with Horizontal 
stretch to desired effect). Executed with Map to window center. - Position 4 Glyphs on the 4 corner of the 
plate and repositioned on each 159 frames. Executed Velocity with manual matching. - Performed 
Stabilization Reconstruction. -Using the select tool selected area of the video clip with the plate centered. 
Performed the Translational Crop function left 624 top 250 right 1277 bottom 762. - Executed Velocity 
with correlation matching (translational only). - Performed Motion deblur Wiener parameters with motion 
scale 100%. - Performed Sharpen with Sharpness at 1.0 and Radius at 1.5. - Exported Video clip as .avi 
file at 30 fps. - Open .avi file in Ominivore Viewer 3.4 and export all frames as BMP files with Overlay 
frame counter. - Open BMP files as movie in Cognitech Video Investigator Release 64 build 7.0. 
Exported as .avi file at 30 fps. - Open .avi file in Ominivore Viewer 3.4 and exported video clip as 
Lossless H264 MP4. Final frames.avi_lossless.mp4 (654 x 513). - Choose frames/BMP files 151, 152 
and 153 for final representation of plate.

LVHCQA

AMPED FIVE - Rotate (180°), - Correct Perspective, + Source Points (P1: 1407:833 ; P2: 1436:856 ; 
P3: 1435:913 ; P4 1404:885), + Output Selection (x: 1415 ; y: 859 ; w: 110 ; h: 55), Perspective 
Stabilization (Hybrid Tracking), + Settings (P1: 1384:911 ; P2: 1423:814 ; P3: 1721:632 ; P4: 
1735:933, - Crop, + Selection (x: 1299 ; y: 788 ; w:352 ; h: 176), - Turbulence Deblurring, + 
Settings (Strength: 1.5453 ; Noise: 0.2907), - Unsharp Masking, + Settings (Strength: 0.2 ; Size: 43 ; 
Threshold: 20), - Automatic Color Equalization, + Settings (Method: Global ; Strength: 3.2), - Resize, + 
Zoom 1.5 Lanczos

M23ULW

steps are shown in the uploaded report by amped software. [Report was not included here.]MM3TAV

Amped FIVE 20240711 Revision 34212, x64. Medex 2.167 Reference Library Version: 2.2.132. 
FFprobe 4.2.2, x64. MediaInfo 24.06, x64. In AF, imported VideoMaterial.MOV to complete Part 2 of 
proficiency test as per the test providers instructions. The following filters/processed were applied to 
VideoMaterial.MOV in Amped FIVE: Rotation - the canvas needed to be rotated 180. Crop - reduced 
the canvas size as the AOI is the license plate. Utilizing the following filters to clarify the recording: 
levels, contrast/brightness, and smart adjust. Perspective Stabilization: Applied the filter to the four 
corners of the license plate. Correct Perspective: Corrected the perspective of the license plate. 
Averaging filter: Removed a small amount of noise. Laplacian Sharpening filter: Sharpened the 
recording. Annotate: As per the instructions from CTS, added a macro to display the frame number 
during playback. Added frame number macro to lower right corner of recording. As per the instructions 
from CTS, exported the recording in a MP4 container with H264 encoding as 24-5581_Clarified.mp4.

N48MEA

Please see the uploaded Amped 5 Report for all methods/tools utilized 
(CTS24-5581_AmpedFIVEreport_[Name]). [Report was not included here.]

NJMLLV

Adobe Premiere Pro. Corner Pin Filter: Upper Left = -516.0, -12.0, Upper Right = 2414.0, 113.8, 
Lower Left = -512.0, 740.6, Lower Right = 2414.0, 1121.9. Warp Stabilizer: Result = Smooth Motion, 
Smoothness = 50%, Method = Position, Scale, Rotation, Framing = Stabilize, Crop, Autoscal, 
Additional Scale = 100%. Crop: Left = 78.0%, Top = 56.0%, Right = 0.0%, Bottom = 0.0%. Motion: 
Position = -1277.0, -198.0, Scale = 300, Rotation = 0.0, Anchor Point = 960.0, 540.0, Anti-flicker 
Filter = 0.00. Levels: RBG Channels Input Levels = 44,1.00,192, Output Levels = 0,255. Timecode: 
Position 123.0, 988.4, Size = 15.0%, Opacity = 40.0%, Format = Frames, Timecode Source = Clip, 
Offset = 0. Export Settings: File Name = VideoMaterial_Adjusted.mp4, Format = H.264, Video Frame 
Size = Full HD (1920x1080), Video Frame Rate = 29.97, Video Field Order = Progressive

NQHNM8

Utilized AMPED5 software to examine the video. The rotate, correct perspective tool, local stabilization 
tool were used to better view the license plate. The crop tool, add text for frame numbers, frame 
averaging tool, sharpen tools, contrast brightness, exposure and levels tools were used for video 
enhancement to obtain a clearer image of the license plate. Used the video writer and image writer in 
AMPED5 to export the product files.

NQZUMX
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Software used: Amped FIVE 31095. Clarification Steps: Rotate/Angle: 180/Resize Image to Fit: 
true/Interpolation: Bicubic/Background Color: #00000. Correct Perspective/Source Points: 1383, 
899-1413, 921-1412, 982-1382, 952/Target Selection: x:870, y:495, w:180, h:90. Local 
Stabilization/Background Color: #000000/Selection: Static Tracking, Reference Selection(s) 0: x:918, 
y:288, w:308, h:283. Crop/Selection: x:839, y:247, w:489, h:371. Deblocking/Strength: 2/Selection: 
Whole Image. Contrast Brightness/Contrast: 20/Brightness: 20/Mode: Linear/Selection: Whole Image. 
Levels/Value: 235, 110, 10/Red: 255, 127, 0/Green: 255, 127, 0/Blue: 255, 127, 0/Selection: 
Whole Image. Unsharp Masking/Strength: 0.2000/Size: 21/Threshold: 0/Mode: Intensity/Selection: 
Whole Image. Add Text/Text: $POSITIONFRAMES/Text Style: 'segoe ui'20 windows-1252, #FFFFFF, 
Left, Bottom/Background Color: #000000/Background Shape: Selection/Selection: Whole Image. 
Video Writer/Container and Video Codec: mp4-H264/Audio Codec: none/Frame rate: 29.97/Quality: 
Visually Lossless/HW Acceleration: None. Sparse Selector/Frames: 0, 150. Sequence Writer/Format: 
Bitmap/First Frame Number: 0/Image Filename: 24/5581 Clarified Image/Write Image Sequence PDF: 
false. [Participant submitted data in a format that could not be reproduced in this report].

P3V8K9

all methods are clarified in the report with steps. [Report was not included here.]PFWY4R

6/24/2024 at 11:03am I was emailed from CTS Lab Account Invite. 6/24/2024 11:04 am I was 
emailed from [Name] with further instruction on the proficiency testing process. 6/24/2024 11:22 am I 
completed the first step to create a account with CTS. 6/24/2024 11:31am I completed the second step 
joining the group. 6/24/2024 11:39 am [Name] sent me an email advising me that he assigned the 
test. 6/24/2024 11:46 am I downloaded the zip file from the test. 6/24/2024 11:50 am I started to 
complete the Hash verification of the zip file, unzipped original, and unzipped copy of the original. 
7/17/2024 8:45am Took the copy of the original and placed it into AMPED FIVE. Completed: Video 
Loader, File Info, Hash Code, Rotate, Correct Perspective, Global Stabilization, Crop, Levels, Automatic 
Color Equalization, Add Text. 8-9-2024 at 9:28am Started back working on the case and opened 
project in AMPED FIVE. Completed: Video Writer – mp4 H264, Image Writer on the three best images 
of the suspected plate, Exported the Report from AMPED FIVE.

PXEYWA

Tools: Amped FIVE Build Date 20240416, Revision 33279. Settings: Rotate, Correct Perspective, 
Global Stabilization, Local Stabilization, Crop, Resize, Levels, Unsharp Masking, Add Text, Video Writer, 
IFrames Selector, Sparse Selector, Sequence Writer.

Q8K8C9

Source file imported into Adobe Premiere Pro: Video Motion > Position 1165/614, Scale 500 Video 
Effects > Distort > Corner Pin - Upper Left -4620/0, Upper Right 2030/329, Lower Left -5915/1432, 
Lower Right 2379/1519 Video Effects > Distort > Warp Stabiliser - Stabilisation: No Motion, Method: 
Subspace Warp Clip > Field Options > Flicker Removal Lumetri Color: Auto Video Effects > Video > 
Metadata & Timecode Burn-in > Size 15%, Opacity 100%, Metadata: Clip Timecode, Position 29/110, 
Size 100%, Format: Frames, Offset 00:00:00:00

QXTL8W

Tools used: FFmpeg (version 6.6.1), Python 3.8.10, opencv-python (version 4.6.0.66), numpy(version 
1.24.4), VISystem(version 5.0.0), Photoshop (version 23.4.1). Processes: 1. Extracted frames from 
VideoMaterial.mov using FFmpeg. 2. Did a perspective transformation on all the frames using a python 
program. The width-to-height ratio of the license plate was set to be 2:1. 3. Conducted a video 
stabilization using VISystem. The license plate area was designated as the ROI and the stabilization 
process was repeated 3 times to get a fine alignment. 4. Cropped around the license plate using 
VISystem. 5. Made adjustments on the frames using the Camera Raw Filter in Photoshop (Exposure: 
+0.6; Whites: +45; Clarity: +40; Dehaze: +30). Used Levels adjustment in Photoshop to correct the 
tonal range and color balance of the frames ( Midtone: 0.75; R channel: 0,161; G channel: 0,164; B 
channel: 0,155). 6. Overlaid the frame numbers as text near one of the upper left corner of the video 
using a python program. 7. Converted the result images into a video named Result.mp4 using FFmpeg 
(-c:v libx264 -r 3 -pix_fmt yuv420p).

REFN4Q
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Two images were taken from the video done with enhancements and perspective correction requested 
for the test. The images are named VideoMaterial134 and VideoMaterial155. Another still image was 
made from frame averaging frames 0, 60, 150, 156 and 158. The frame averaged image was opened 
in photoshop and cropped, Camera Raw Filter was used, resized to 200% using nearest neighbor, 
Unsharp mask was applied to the Lightness layer of a LAB image and changed back to RGB. The image 
name is Multiple_FA_NoPerspCorr. Between the two different approaches on the images, approximately 
five of the seven characters on the license plate can be determined. Video Enhancement – Methods and 
tools Lumetri Color in Adobe Premiere Pro was used for the enhancements. Light and RGB Color / 
Curves was used in the enhancement process. 1. Warp Stabilizer was used in Adobe Premiere Pro 
v24.5.0. The settings used are as follows. A. Result – No Motion, Method – Subspace warp, 
Borders/Framing – Stabilize, Crop, Auto-Scale. 2. The image was then cropped using the following 
settings. A. Left – 70%, Top – 78%, Right – 20%, Bottom – 4%, Edge Feather – 0. 3. The enhancement 
was performed using the below listed Lumetri Color Settings. A. Basic Correction settings. Color – no 
changes, Light – Exposure – (0.8), Contrast – (19.6), Highlights – (0), Shadows – (6.3), Whites – (9.8), 
Blacks (-16.1). B. Curves. 4. Frame numbers were added using metadata & Timecode Burn-in. A. Size 
15%, Opacity 40%. B. Line 1 – Positiion – 1450.0-720.0. C. Size – 100%. D. Format – Frames. E. 
Offset – 00;00;00;00. 5. All frames were exported (once before enhancements and again after 
enhancements were made. 6. The enhanced frames were taken into photoshop and a "Perspective 
Warp" transform was done to change the pespective of the license plate. An action was created and the 
same action was applied to all remaining frames. 7. The perspective corrected frames were brought into 
Premiere Pro as a sequence, dropped on the timeline and an MP4 of the stabilized, perspective 
corrected video was exported. 8. Three of the better frames were saved to turn in for the proficiency test.

RF9GYA

The video was enhanced using Amped FIVE. The following processes/filters were applied to video: 
-correct perspective, -rotate (-90), -perspective stabilization, -crop (x: 810, y: 467, w:133, h:71), -curves 
(x:0, y:0)(x:89, y:155)(x:255, y:255), -unsharp masking (strength: 0.23, size: 49, threshold: 0), -resize 
(output: 266x142), -add text (frame numbers). Exported video as a lossless mp4. Exported frame 158 as 
a bmp. Applied frame averaging to frames 149-158. Exported averaged frame as a bmp. Additional 
software settings are retained in my technical notes; however, they seemed excessive to include in this 
form.

RQ6K34

load video-rotate-correct perspecitve-local stab.-crop-laplacian sahrp-contrastbrightness-addtext. we 
used amped five

RZEPFU
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Opened the exhibit file labelled "VideoMaterial.MOV" in Amped FIVE (revision 34212). Created four 
chains using the MOV so that different processes could be attempted. Added the File Info and Hash 
Code filters to all three chains. The video has been rotated 180 degrees. Used the Rotate filter to correct 
the rotation on all chains. On playback video is jittery. The car is stationary, but the video appears to be 
affected by vibrations. The car is parked at an angle to the camera so that the registration plate is not 
clear. The footage is recorded during the day in colour however the car is in shadow. The registration 
plate is still visible. The Amped FIVE report contains detailed information of the filters used. As per the 
instructions the following processes were applied: Chain 1 - Correct Perspective filter was used to correct 
the perspective of the registration plate and make it appear that it was more front on with the camera. 
The IFrame Selector filter was used to show only the I frames in the footage. Perspective Registration was 
added to align the perspective of the I frames. The footage was cropped to focus on the registration 
plate. The Smart Resize filter was used to zoom the cropped selection while keeping the aspect ratio. 
Smart Adjust was used to improve the contrast of the image. The Add Text filter was used to add the 
original frames of the video to the bottom right corner starting at frame 0. Used the Image Writer to 
export two frames of the footage as still images in PNG format. Used the Video Writer to export an MP4 
video with H264 codec at the original FPS. Used the Video Writer to export an MP4 video with H264 
codec at 2 FPS to slow the footage down. Chain 2 – Correct Perspective filter was used to correct the 
perspective of the registration plate and make it appear that it was more front on with the camera. The 
Range Selector was added to select a range of frames where there was less movement in the video. The 
Perspective Stabilisation filter was added to stabilise the footage and correct for the vibrations. The 
footage was cropped to focus on the registration plate. The Smart Resize filter was used to zoom the 
cropped selection while keeping the aspect ratio. The Parametric Curves filter was used to adjust the 
lights, darks, and shadows in the image to assist with edge definition of the characters. The Add Text 
filter was used to add the original frames of the video to the bottom right corner starting at frame 0. 
Used the Image Writer to export two frames of the footage as still images in PNG format. Used the 
Video Writer to export an MP4 video with H264 codec at the original FPS. Used the Video Writer to 
export an MP4 video with H264 codec at 2 FPS to slow the footage down. Chain 3 – Correct 
Perspective filter was used to correct the perspective of the registration plate and make it appear that it 
was more front on with the camera. The Perspective Stabilisation filter was added to stabilise the footage 
and correct for the vibrations. Perspective Super Resolution was used to create a single image by 
merging all frames from the video once stabilised. The footage was cropped to focus on the registration 
plate. The Smart Resize filter was used to zoom the cropped selection while keeping the aspect ratio. The 
Parametric Curves filter was used to adjust the lights, darks, and shadows in the image to assist with 
edge definition of the characters. The Add Text filter was used to add the original frames of the video to 
the bottom right corner starting at frame 0. Used the Image Writer to export the image in PNG format. 
Chain 4 - Correct Perspective filter was used to correct the perspective of the registration plate and 
make it appear that it was more front on with the camera. The Range Selector was added to select a 
range of frames where there was less movement in the video. The Perspective Stabilisation filter was 
added to stabilise the footage and correct for the vibrations. Perspective Registration was added to align 
the perspective of the available frames. The Parametric Curves filter was used to adjust the lights, darks, 
and shadows in the image to assist with edge definition of the characters. The footage was cropped to 
focus on the registration plate. The Smart Resize filter was used to zoom the cropped selection while 
keeping the aspect ratio. The Add Text filter was used to add the original frames of the video to the 
bottom right corner starting at frame 0. Used the Image Writer to export two frames of the footage as 
still images in PNG format. Used the Video Writer to export an MP4 video with H264 codec at the 
original FPS. Used the Video Writer to export an MP4 video with H264 codec at 2 FPS to slow the 
footage down.

T9PB33
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Amped FIVE software was used. Build date: 20231018. Revision: 31095. 1. Rotate: The video was 
rotated by 180 degrees, with bicubic interpolation. 2. Correct Perspective: Based on Frame 158: a. The 
approximate four corners of the front licence plate ((1384, 901), (1412, 923), (1411, 979), (1382, 
952)) were selected to correct for the perspective of the front licence plate. b. As the resulting target 
selection had a height of 80 pixels, the width of the resulting target selection was changed to 160 pixels 
before centering the selection ((880, 500), width: 160 pixels, height: 80 pixels). 3. Perspective 
Stabilization: The front of the car ((986, 312), (1418, 345), (1418, 510), (986, 488)) was selected for 
stabilisation based on perspective, hybrid tracking (which compared the current frame with both the first 
and the previous frame) and bicubic interpolation. 4. Crop: The video was cropped to the region of 
interest around the front licence plate ((854, 284), width: 480 pixels, height: 255 pixels)). 5. Levels: The 
levels of the video were adjusted, with highlights of 200, midtones of 105 and shadows of 10 for value. 
6. Contrast Brightness: The contrast and brightness of the video were both adjusted to 35, using the 
linear mode. 7. Add Text: The frame number was added to the lower right corner of the video. 8. Video 
Writer: The final product was saved as a .mp4 file, with H264 video codec, a frame rate of 29.9700 
frames per second and visually lossless quality. 9. Sparse Selector: Three frames (0, 149 and 155) were 
selected to represent the clearest images of the front licence plate. 10. Sequence Writer: The above 
three frames were saved as .png files.

TWCB7A

Amped FIVE software was utilized for all steps with this request: Rotate the file 180 degrees to proper 
orientation. Correct perspective of a plane of interest within the image to the following settings: • Source 
Points: 1406, 831 - 1437, 855 - 1436, 915 - 1404, 883. Quadrilateral to transform into a rectangle. 
• Target Selection: x: 859, y: 469, w: 171, h: 146. Target rectangle to map the source points to. Local 
Stabilization - stabilized to the license plate. Crop - cropped to the area of interest of the license plate. 
Levels- adjust intensity and color levels to the value of 122, 77, 32. Resize - enlarge the image to 
586x488. Add Text- Add the frame numbers to corner as requested

TXJT46

[Participant did not complete the enhancement section]U8M2LQ

Test documentation was reviewed and a subfolder containing VideoMaterial.MOV was downloaded. The
item was archived according to laboratory policy and verified via hash. A working copy was also created 
and verified with a hash value comparison. Amped FIVE was used to review the file properties, observe 
the recording and video/image clarification. The following filters were applied: • Rotate; 180 • 
Corrective perspective by using four corners of license plate • Aspect applied using noted ratio in 
instructions. Used measurement tool to confirm ratio was approximately 2:1. • Applied Global 
Stabilization (Maximum Shift: 50, Frames 29) • Crop to ensure license plate was visible throughout 
frames • Adjusted Brightness Contrast (Logarithmic, Contrast 15, Brightness 16) • Unsharp Masking 
(0.3600, 15, 0) • Added Text Marco to include page/frame number in upper left corner (0-158) • 
Video was saved as "MP4" format using H264 Codec with visually lossless quality (Video Writer) • Used 
Bookmarks to select 7 best clarified frames. Narrowed down to 3 best frames. Saved as TIF Format. • 
Work product was archived according to laboratory procedures and verified. Files for upload: • 
[Lab]-24-0118_frame 149_clarified.tif • [Lab]-24-0118_frame 153_clarified.tif • [Lab]-24-0118_frame 
158_clarified.tif • [Lab]-24-0118_Video_Clarified.mp4

V2X39M
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Amped Five version 22997 was used for the submitted work. For the Video file and stills A and B the 
below process was used. The video was rotated through 180 degrees to display correctly. Correct 
perspective filter was applied. Perspective stabilisation was applied, nearest neighbour interpolation was 
used. Crop to area around license plate, size 500 x 280. Frame position filter applied. Remove frames 
filter applied to remove poor quality frames interfering with tracking. Levels adjustment on histogram 
applied, highlights 149, midtones 83, shadows 18. Unsharp masking filter applied to sharpen image, 
strength 0.3400, size 99, threshold 0. Write the file as a Mp4, h264 encoded video file at 29.97 fps, 
visually lossless setting. The same method was applied with a write image filter used for stills A and B in 
Bitmap format. Still C - Frame averaged. The video was rotated through 180 degrees to display 
correctly. Correct perspective filter was applied. Sparse selector applied to select best frames for 
tracking. Perspective stabilisation was applied, bicubic interpolation was used for a smoother image. 
Frame average filter applied. Levels adjustment on histogram applied, highlights 114, midtones 57, 
shadows 0. Laplacian sharpen filter applied to define edges, strength 0.7600, mode=intensity. Crop to 
area around license plate size 455 x 277. Write file as a Bitmap

VCGJZT

Imported MOV file in to Amped FIVE (Revision: 33279) Used Rotate filter to rotated image by 180 
degrease. Used Corrected Perspective filter to adjust the perspective of the license plate. Selecting the 
license plate, used Perspective Stabilization filter to stabilise the license plate. Used Crop filter to crop 
around the license plate. Sharpened the video using the Unsharp Masking filter. Selecting only the 
license plate area, used the White Balance filter. Used the Curves filter to lighten and increase the 
contrast of the video. Used the Add Text filter to overlay frame numbers in bottom left hand corner, 
starting with the first frame as 0. Exported as MP4 file with H264 video encoding. Exported frames 154 
and 155 as PNG files. Amped FIVE report generated saved to project folder.

VKRLLU

2024 CTS Proficiency Test - Below is the process used to reach the requested video enhancements after 
examining the provided test material. Various forensic accepted software programs, which are available 
to the Forensic Imaging Unit, were used to export the requested test files. Video File – 
VideoMaterial.mov, 10.1 MB (10,622,916 bytes). Video Length 00:00:05 Seconds. MPEG Video 
(H264) 1920x1080, 29.97 fps, 16,016 kbps, yuv420p. Axon Investigate v.4.1.1: Examine video file 
and exported still images of full length of file – 159 frames TIF format. Explored options for perspective 
adjustments, stabilization, and exports. One still image capture used for final submission. Adobe 
Photoshop 2024 v.25.9.1: Imported video file to explore options for perspective adjustments, 
stabilization, and exports. Decided to crop video to area of interest, which is the front of the vehicle, 
verses stabilizing the whole video frame. Used Perspective Warp effect to obtain requested angle of 
license plate. Unable to export to MP4 file after effect applied. Exported video frames as layers with the 
effect applied. Still image captures of license plate enhanced with Levels 20-1.50-200. Adobe Premiere 
Pro 2024 v.24.5.0: Imported video file to explore options for perspective adjustments, stabilization, and 
exports. Unable to render desired perspective adjustment. Decided to import 159 still image layers 
(which was cropped to the front area of the vehicle and had Perspective Warp applied) from Photoshop 
files to create a video file for playback. Used Warp Stabilizer > No Motion > Perspective Scale > 
Stabilize Only > Detailed Analysis. Cropped tighter to license plate area, applied levels (16-1.82-200) 
adjustment and unsharp mask filter (64-8.0-0) Note: The above sequence and methods are accepted 
under our Standard Operating Procedures. It was not indicated that exact frame timing was of concern 
in the final video, so the video to still image to video process is acceptable in this scenario. All 
intermediate file saving was completed using lossless formats to ensure that image quality was 
maintained throughout the process.

XDJYK6
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** Cannot upload more than one file - enhanced video file selected - full outline of additional files 
included below ** Amped-FIVE video software utilised to perform enhancing process. Specs: Software 
version info - Build date: 20240711, Revision: 34212. Summary of processing tools utilised: > Video 
Loader - Imported original provided video file "VideoMaterial.MOV." > Rotate - Rotated the image 180 
degrees. **NOTE this tool was used as the clip imported upside down** > Correct Perspective - 
Corrected the perspective of the licence. The four corners of the licence used as source points. 
Width-to-height ratio of 2:1 achieved by stretching width to match the pixels of the height. (184w x 92h 
pixels). > Local Stabilization - Static tracking, selection was around the licence pate area. > Crop - 
Cropped so that licence occupies approximately middle 1/3rd of frame. Allowing buffer space around it. 
> Levels - Adjusted midtones. > Parametric Curves - Adjusted highlights, midtones, and shadow. > Add 
Text - Added frame count as numbers in bottom right corner of frame. White text. > Video Writer - 
Exported video file as H.264 MP4 named "Processed Video File". > Image Writer - Exported frame 0 as 
PNG named "Frame Select 1". > Image Writer - Exported frame 150 as PNG named "Frame Select 2"

XGLWVX

1. ffmpeg => individual frames frame001.bmp - frame159.bmp, 2. Photoshop => perspetive warp 
each frame squaring up plate and saved as jpg files, 3. ffmpeg => concatenate using ffmpeg -f concat 
-i files.txt -c copy output.mp4 where files.txt is a list of the changed perspective jpg files. 4. import 
output.mp4 into Premiere 5. Warp Stabilize filter with no motion, position/scale/rotation, 
stabilize/crop/autoscale. 6. Add Timecode effect with frame number next to plate. 7. Enlarge 372% and 
position the frame at -822 x -920. 8. Sharpen 40. 9. Adjust positioning of Timecode to lower left 
corner. 10. Export to VideoMaterial_enhanced.mp4 in H.264 format. 11. Selected Frame 156 from 
original individual frames from step 1. 12. Enhanced and cropped frame and saved it to 
frame156_crop_persp_b&c.bmp

XV4PJ4

Question 2-1: Note methods or tools used and settings for the video enhancement here.

This was a free form question on methods and tools used. No consensus response expected. Consensus Result:
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Part 2: Video Enhancement Instructions - Perform the tasks listed below and provide an enhanced derivative video for 
review.
A. Trim the video so it starts at frame 544 - the first frame of time stamp 04:22:35 PM, and ends at frame 1758 - the 
first frame of time stamp 04:23:56 PM.
B. Adjust the frame rate so that it plays back as close to real time as possible.
C. Crop the video in at least to the top right quarter of the frame. You can crop closer into the subjects if you want.
D. Enhance/clarify the video. Use any methods or software tools deemed necessary to improve the viewers ability to 
see and or understand what is happening in the scene. Note the method or tools used and settings below
E. Enlarge your new cropped video by 2x.
F. Save your enhanced video in .mp4 format with a visually lossless or low constant rate factor (CRF).

WebCode Observational Notes

2PMJBM Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. The output PNG image file for frame 
139 appears to have undergone different or additional processing compared to the output MP4 file, 
when visually compared. No explicit mention of this different/additional processing is provided in the 
participant's notes.

2RNRFW Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

2XE2PV Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

37NQ4U Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step B observational note: 
Processing notes do not include evidence of stabilization. Step C observational note: Cropping was 
completed however, the entire license plate was not visible, as requested. Step F observational note: 
Review of the output MP4 video file revealed that frames 156 and 158 are missing (even though the 
participant provided a still image of frame 158). Step G observational note: The two exported images 
were provided in JPG format, which is not one of the three requested still image formats (PNG, BMP, 
or TIFF).

39RLMW Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Participant's notes indicate that 
two output MP4 files were produced but no MP4 files were provided in the participant's materials. 
Participant used a lens correction filter in an attempt to correct the perspective but the perspective did 
not appear corrected. Frame numbers were not overlaid for the output video file, as requested; the 
participant noted that the tool they used (Axon Investigate Pro) "does not allow the type of overlay."

3QAKUF Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

3QWT2Y Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

4YJ98E Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). The participant provided no 
output MP4 video or still image files. They provided only a PDF report from Amped FIVE software 
which does include bookmarked images at various stages. Based on the FIVE report, some 
enhancement and perspective correction were applied but no stabilization filters were employed.

6XMCVP Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

73WT6D Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.
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7EQ9RU Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

7NBD2E Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step A observational note: 
Participant used Media Player Classic in an attempt to correct the perspective but the perspective did 
not appear corrected. Step E observational note: Individual frame numbers were not overlaid on the 
output video files; instead, static displays of "0/135" and "0/154" were overlaid.

8BK3RE Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

8KV6DE Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step F observational note: The 
supplied output video file is a QuickTime MOV file, not an MP4 as requested, though they are related 
container formats. Based on the overlaid frame numbering, the supplied video file also appears to 
only include the first 50 frames of the original video, and is missing frames (e.g., frame 20), some 
frame numbers extend across frames having different content (e.g., frame 21), and the frame rate is 
inconsistent throughout the output video file. However, these issues may be accounted for by one or 
more of the processes applied in Amped FIVE, but the supplied notes appear to be incomplete (e.g., 
filter names and possibly settings are missing).

8WK66G Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

9Y4FGR Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

A8X93Q Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

A9N7GP Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step A observational note: 
Participant used lens correction and rotate filters in an attempt to correct the perspective but the 
perspective did not appear corrected. Step C observational note: Cropping was conducted but the 
entire license plate is not visible throughout the cropped version, as requested. Step E observational 
note: Frame numbers were not overlaid for the output video file, as requested, though the output still 
image does include a frame number.

ACNHCP Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

AV4RDP Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

B23TTA Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step D observational note: The 
supplied MP4 file features a picture-in-picture of a perspective-corrected/ stabilized/ cropped/ 
frame-averaged/ enhanced inset using three source frames over what appears to be the original 
video. Step E obversational note: No MP4 file was provided of the perspective-corrected/ stabilized/ 
cropped/ enhanced video by itself with overlaid frame numbers, as requested.

B3JPKA Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.
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B7J2GA Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step E observational note: 
None of the supplied output MP4 files include overlaid frame numbers, as requested, though the three 
output PNG image files do include frame numbers. The output PNG image files appear to have 
undergone different or additional processing compared to the output MP4 files.

BJH3TB Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. Based on the overlaid frame 
numbering and frame counts, the supplied video files include only the first 20 frames of the original 
video.

CACG79 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. The supplied PNG still image file 
appears to have undergone additional enhancement or spotlighting around the plate's characters, 
which is not documented in the participant's notes.

CC4FK8 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step D observational note: It is 
not evident that the stabilized/perspective corrected video file was enhanced or clarified. The 
brightness/contrast adjustments appear only to have been applied to frame-averaged still images.

CJ33AL Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

CRD6VM Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

DBZD7M Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

DJW977 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. The output MP4 video file contains 
only three frames compared to 159 frames from the original MOV file. No details regarding the 
processes employed were provided, other than the software (Amped FIVE), so it is difficult to evaluate 
the video processing as a whole.

EDKJ6A Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. The provided "FRAME 0.bmp" and 
"FRAME 154.bmp" image files are bit-for-bit identical. A review of the supplied Amped FIVE HTML 
report indicates in the "Image Writer" filter that "Frame Position: 154" was exported as "FRAME 0.bmp" 
and not "FRAME 154.bmp."

FKZPEL Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

GJLF2E Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

GWBEV3 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

HNZDA2 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

HVA2KE Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.
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J8J2UD Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

JZNYT2 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. The frame numbering appears to 
have been reset to "0" regardless of the range of frames selected by the participant; the intent of the 
frame numbering was to preserve the numbering of the supplied MOV file. The two still images 
appear to have undergone different enhancement processes, even though that is not explicitly 
discussed in the participant's notes.

KV8Q63 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. Clearly, the video content was 
perspective-corrected and stabilized, but the supplied Amped FIVE notes include only the video 
enhancement processes. A review of the output MP4 video file revealed that several frames (frames 
16, 64, 81, 88, 104, 110, 111, 116, 124, and 130) contain black raster video data and no image 
data from the supplied MOV file. This may have been introduced during a stabilization process, but as 
stated above, no such process is included in the participant's notes.

LNKKHF Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

LVHCQA Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. Frame numbers are out of 
chronological order in the output MP4 file. Still images with overlaid numbers 151, 152, and 153 
(provided as Bitmap images) are actually the 152nd, 151st, and 155th frames, respectively, as they 
appear in the output MP4 file.

M23ULW Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

MM3TAV Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). The participant provided no 
output MP4 video or still image files. They provided only a PDF report from Amped FIVE software 
which does include bookmarked images at various stages. Based on the FIVE report, some 
enhancement and perspective correction were applied but no stabilization filters were employed.

N48MEA Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. The two exported Bitmaps for frames 
150 and 158 appear to have undergone a different clarification process(es) compared to the output 
MP4 file. The production of the still images is not discussed in the participant's notes.

NJMLLV Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

NQHNM8 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. A review of the output MP4 video file 
revealed that frames 0 and 1 contain identical content (other than the overlaid frame number) but are 
unique frames within the supplied MOV file. Also, the total number of frames in the output MP4 file is 
158, not 159 as in the supplied MOV file.

NQZUMX Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step D observational note: An 
enhancement of the video was not conducted. The supplied MP4 file is the perspective-corrected/ 
stabilized/ cropped form of the video, but the enhancements were applied afterward for the 
production of the still image files.
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Forensic Video Enhancement Observations

WebCode Observational Notes

P3V8K9 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

PFWY4R Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). The participant provided no 
output MP4 video or still image files. They provided only a PDF report from Amped FIVE software 
which does include bookmarked images at various stages. The only enhancements/ clarifications 
applied were various deblurring filters. Global stabilization and perspective correction was applied 
based on the FIVE report.

PXEYWA Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

Q8K8C9 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

QXTL8W Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. The total number of frames in the 
output MP4 file is 157, not 159 as in the supplied MOV file; frames 157 and 158 are missing from 
the output MP4 file. The supplied BMP image file for frame 0 appears to have undergone different or 
additional enhancement compared to the output MP4 file.

REFN4Q Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

RF9GYA Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

RQ6K34 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. Review of the output MP4 video file 
revealed that frame 130 contains black raster video data and no image data from the supplied MOV 
file.

RZEPFU Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following exception(s). Step G observational note: 
Three exported images were provided but in JPG/JFIF format, which is not one of the three requested 
still image formats (PNG, BMP, or TIFF).

T9PB33 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

TWCB7A Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

TXJT46 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

U8M2LQ [Participant did not provide any material for this portion of the test.]

V2X39M Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

VCGJZT Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

VKRLLU Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.
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XDJYK6 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

XGLWVX Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps.

XV4PJ4 Submitted enhanced file(s) were reviewed by an expert who confirmed that this participant completed 
all requested video enhancement steps with the following notes. The output MP4 file has an additional 
frame (total of 160 frames compared to 159 frames in supplied MOV file). Frame 159 of the output 
MP4 file appears to be a duplicate of frame 158 but with a slight vertical shift upward. The exported 
Bitmap for frame 156 appears to have undergone a different enhancement process than the output 
MP4 file.
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There is no circumstance in which a request for clarification of a license plate or other object would be 
provided to a requestor in a video format. The processing order presented by this test is not in line with 
best practices (scientific image generation model).

2RNRFW

I stabilized the video prior to correcting the perspective, which is the correct order and follows current 
best practices.

7EQ9RU

Open-source software ExifTool was used to view the properties of the video analyzed in the study, 
utilizing the cmd command console. A FRED workstation was used.

7NBD2E

The video enhancement I used was a levels adjustment to brighten the image. I then used a sparse 
selector to select what I felt were the clearest frames, then used a frame average process to try and 
reduce the compression artifacts. This produces a single image rather than a video however so I have 
provided this (MJL-2-24-5581) as well as the video and still frames requested. Full details of the tools 
and settings can be seen in the report provided.

8WK66G

I uploaded four (4) files, but I was not able to confirm they were successfully uploaded: 
24-5581_[participant code]_VideoMaterial.mp4, 24-5581_[participant code]_VideoMaterial_Frame 
0.bmp, 24-5581_[participant code]_VideoMaterial_Frame149.bmp, 24-5581_[participant 
code]_VideoMaterial_Frame158.bmp.

A8X93Q

Based on the way this test was written, specifically in the Video Enhancement instructions, it seems as if 
the test is testing the knowledge of using Amped Five and not necessarily how to process a video/image 
for a license plate. If not for the instructions provided, I would have processed this case somewhat 
differently, but still received similar results.

ACNHCP

This request is outside the scope of our usual unit requests.B3JPKA

This test was conducted at the [Laboratory] with 10 expert personnel.B7J2GA

The provided instructions for enhancement are different than what analyst would normally do. Therefore, 
instructions were followed first and then a second analysis was conducted as the analyst would normally 
do. The second analysis result is named Technique 2. Flies were uploaded as a zip file due to uncertainty 
that multiple files were being attached. Please reach out if 5 files (4 images and 1 mp4 are not received).

CJ33AL

Another really challenging test the only comment I would like to make is that I Personally would not of 
followed the method asked to get any Vehicle index plate details from the car, personally I would not of 
produced any video I would of produced a still following majority of the steps I have done in the test but 
along with frame averaging.

EDKJ6A

I appreciate the complexity and difficulty of creating these types of tests however, I felt like this test came 
out a little too much on the awkward side and missed the mark a little bit. Being prescribed a specific set 
of instructions on how to process the video, and in a specific order, led to some concerns and issues with 
our workflow. Having used Amped FIVE before, I know that these processes and this sequencing can be 
easily accomplished with that tool. Our laboratory does not currently have Amped FIVE, so we have to 
use workarounds with other tools that we do have access to, which may limit our results and greatly 
increases the amount of time required to accomplish a task. It is important to our unit that analysts review 
requests, communicate with the customer on possible deliverables using their knowledge and experience 
to help the customer decide on the best presentation format, know when they do not have the right 
toolset for a requested work, and that they clearly articulate any limitations with outputs or inabilities to 
produce requested work. Due to the sample video, there was also some level of thinking that we would 
never produce the requested work had this been a real case. I understand that tests don't always 
accurately represent real scenarios but in this particular scenario it was a little bit difficult to divorce 
yourself from the idea that you wouldn't do this on a real case. In this instance, simple still image 
extraction and basic processing would have been sufficient for a detective to review for a potential lead 
on the license plate and vehicle. Even if we needed to perform additional processing on the video, we 
would not produce a video file showing the stabilized and perspective-corrected plate. The stabilization 
and perspective-correction may still be performed, but it would be in service of performing an additional 
technique such as frame averaging. In which case, not all frames of the video would be utilized, and a 

FKZPEL
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video file would not be delivered to the customer. Only the resulting frame averaged image would be 
delivered. Overall, I feel like these tests are moving in a good direction and I appreciate that analysts are 
being tested on more complex techniques, understanding of video evidence, and understanding of their 
tools.

1 - The workflow to achieve the method requested differs from other forensic video accreditation 
standards. 2 - Directions on submission could allow multiple files to be submitted if that is what is 
requested. 3 - When submitting notes or tools used it would be beneficial to submit the report that comes 
from the software rather than "Note methods or tools used and settings" as the software report would 
contain all of those requested.

GJLF2E

The uploaded zipped file contains 1 video file, 3 still image files, and the AmpedFIVE Report, which 
provides additional details about the three enhancement processes performed.

GWBEV3

Was unsure if separate files required so have combined examination into 1 video and 1 still. The video 
combines sections B/D/E/F The enhanced still combines A/C/G Unsure if multiple files were uploaded. 
Also completed hashed of produced work. A triage enhancement document, a peer review of 
enhancement document and overall job quality check.

J8J2UD

The “Part 2: Video Enhancement Instructions” were followed as provided by CTS and an enhanced 
derivative video was exported without omitting any frames from the original video.

KV8Q63

In a "real" case, the goal is to read the license plate. So, in addition to producing the video requested, 
AmpedFive software was used to apply perspective stabilization and perspective super resolution with the 
goal of producing an image that incorporates frame averaging.

LNKKHF

The instructions were not clear on how to upload the four file that were requested. I zipped mine and 
named it [participant code]-24-5581_[participant code]_[Name].zip. I original thought I could upload 
each file, but noticed that each time you uploaded the precious file was replaced. The file upload 
instructions need contain more specific instructions.

LVHCQA

Depending of the tool used, when may have differents values for the bitrate or the frame rate. For this 
exercice, we decided to answer with the most precise values we can get, but in a real case, for a variable 
framerate video, we wil preferer to report a rounded framerate. For this kind of enhancement, we think 
that it will be more efficient to stabilize before correct pesrpective, but we decided to respect the order of 
the exercice instructions. When we have to enhance plates in real cases, we can make proposals for the 
differents caracters of the plate in addition of the enhanced pictures.

M23ULW

Feedback. Part 1: Question 1-2. Multiple tools provided different frame rates, with some reporting as 
variable and others as 29.97 fps. As a numerical value was specifically requested, the answer provided 
was the average frame rate of 29.97 fps.

N48MEA

Part 1: I would suggest picking one hash algorithm and keeping it the same throughout the test. We were 
given the MD5 and SHA1 to authenticate the downloaded and asked to produce a SHA256 for the 
.MOV file. Part 2: Is to prescriptive. The information in "A" is helpful to know the ratio of the plate. The 
instructions should ask the individual to process the video to obtain the best image of the plate (up to 3 
images). Allow the examiner to perform the work in the manner they would in actual case. If the intent is 
to be able to demonstrate the ability to perform some of the functions, write it out in one instruction and 
not break out into individual steps. For example: Process and stabilize the video and obtain the best 
cropped images of the license plate which has a known width to height ratio 2:1. The resulting images 
and video should show the plate having approximately the same ratio of the known plate. The text 
overlay portion is a good process for producing a demonstrative product for a court environment; 
however, this is not necessary for demonstrating proficiency in video processing/analysis.

NJMLLV

1-2). What is the reported frame rate of the MOV files (report as a numeric value in fps) Media Info: 
29.970 fps variable (28.571fps to 30.000fps) Camtasia: 29.97 fps exiftool: 29.972 GSpot: 28.571 
Windows: 29.97 VLC: 29.971726

NQHNM8

Amped Five professional is used for video analysisPFWY4R

It wasn’t clear from the instructions whether both a still capture from the enhanced video and the video 
were required, so both have been supplied: ‘Frame 0 capture.bmp’ and ‘Stabilised and enhanced.mp4’.

QXTL8W

I believe this test would have been best completed using Amped Five which we don't have, making it RF9GYA
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more difficult to perform and most likely giving inferior results. We have a limited toolset in our 
department due to constant budget constraints. I am sure there are many agencies that are in the same 
predicament that we are that don't have the tools you may assume that we all have.

There should be 3 files uploaded to the data sheet "Processed Video (License Plate).mp4", "Still image 
(frame 158).bmp", and "Still image (frame average 149-158).bmp".

RQ6K34

A zip folder containing case notes, attachments, and the processed videos and images has been 
uploaded.

T9PB33

As the issue with perspective occurs at the scene stage of the image generation model, perspective issue 
should be corrected towards the end of the workflow, as stated in 
https://blog.ampedsoftware.com/2023/09/12/correct-the-perspective-of-a-license-plate. In addition, in 
order to obtain a clearer image of the licence plate number, multiple frames from the video could be 
selected to be enhanced, for example frame averaging to give a resultant frame, instead of performing 
the enhancement on the entire video and selecting one to three frames from the enhanced video as 
instructed in this test.

TWCB7A

This is not part of our laboratory typical analysis and was left blankU8M2LQ

**[CTS] confirmed on 8/16/2024 that 4 files (3 images and 1 video) were uploaded to the portal. After 
viewing on three different computers, it appeared like only 1 was uploaded. Email exchanged archived.

V2X39M

In the video, lower quality frames of the license plate were removed due to resulting in a poor viewer 
experience and lower quality output. However this can be identified with the frame numbers as they are 
representative of the position in the original video. Removing these frames for frame averaging results in 
a clearer image and clearer video.

VCGJZT

Unclear whether on upload both the Video sequence and stills have actually uploaded as each had to be 
done separately, may be worth in future listing what the user has uploaded

VKRLLU

Mixed feelings on the "test". Had to spend more time figuring out how to complete the tasks requested 
since I do not have access to other forensic video programs, like Amped Five. After examining the video 
file provided, I would of most likely just captured a few best still images, maybe stacked them and 
exported a good image of the relevant license plate. This might have taken me 10-20 minutes max. I 
spent more time "exploring" options and "experimenting" with the software which I have access to to 
accomplish the task requested, especially in the work order described. The good part was that I learned 
more about other "tools" in the software programs which might be used to accomplish the proficiency test 
request. Tried to do it all within one software package, but unable to. Basically I had to move in between 
three different software programs. I spent hours looking at options and exported files to see what I could 
produce to get the best results, in my opinion. Long story short, this proficiency test definitely pushed the 
envelope of video processing on such a short piece of video, with little variations beyond sharp and out 
of focus frames. I was temped to just create a short video clip using only the "good frames".

XDJYK6

Noting again that I could not upload more than one file in the 'Enhanced Video Examination'. Two 
exported still image .PNG files generated but not able to be uploaded.

XGLWVX

-End of Report-
(Appendix may follow)
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Test No. 24-5581: Forensic Video Analysis

DATA MUST BE SUBMITTED BY Aug. 19, 2024, 11:59 p.m. EDT TO BE INCLUDED IN THE REPORT

Participant Code: U1234B WebCode: X4XX4U
Scenario:
A vehicle of interest was parked outside of a small office building shortly before a fire broke out in the building, which
resulted in millions of dollars in damage. Arson is suspected as the cause. A surveillance camera was attached to the exterior
wall of the building and captured a portion of the front of the vehicle but at an extreme angle (i.e., the camera sensor is
nearly perpendicular to the front plane of the vehicle) just as power was lost to the building due to the fire. The recorded
video was stored in the cloud. The surveillance camera was loosely mounted to the wall and a large air handler nearby
caused the camera to vibrate during capture.

A video file export of the designated recording was made by investigators in QuickTime MOV format. Investigators request
video enhancement of the MOV file to see the license plate of the vehicle more clearly.

Test Instructions:

This test is designed to measure your knowledge and skill in the following digital forensic video processes: Data verification, Media
characterization, Video processing, and Video enhancement.

The skills assessed in this exercise are based on the following best practice documents from the Scientific Working Group on Digital Evidence
(swgde.org):

1. Technical Overview of Digital Video Files

2. Best Practices for Digital Forensic Video Analysis

3. Fundamentals of Resizing Imagery and Considerations for Legal Proceedings

Because of the inherent subjectivity of video “enhancement” due to differences in an individual’s personal preferences and vision, you will
be asked to perform specific tasks including processing the file in a way that is designed to show your understanding of a certain principle or
concept. It is critical that you read the instructions carefully and execute all of the tasks.

Evidence:
To verify a complete and accurate download, use the tool of your choice to verify the integrity of the file.
24-5581 Video.zip MD5 hash value: 2312885104ef9ce990e9a123fddbc307
24-5581 Video.zip SHA1 hash value: 8d75f880e6ea5c439bf96ebbb63770df308d78c9



 Test No. 24-5581 Data Sheet, continued Participant Code: U1234B
WebCode: X4XX4U

1-1). What is the SHA-256 hash value of the MOV file?

1-2). What is the reported frame rate of the MOV file? (report as a numeric value in fps)

1-3). What are the pixel dimensions of the MOV file?

1-4). What is the bit rate of the recorded video in the MOV file?

1-5). How many frames are there in the MOV file?

1-6). Is there an audio track present in the MOV file?

Yes  No 



 Test No. 24-5581 Data Sheet, continued Participant Code: U1234B
WebCode: X4XX4U

Part 2: Video Enhancement Instructions
Perform the tasks listed below and provide an enhanced derivative video file and image files, as requested, for review.
A. Conduct a perspective correction of the designated vehicle’s license plate (that is, process the video such that it closely
resembles the perspective of the license plate as if the camera lens was parallel with it). The license plate has a width-to-
height ratio of 2:1.
B. Conduct a video stabilization of the perspective-corrected video.
C. Crop around the license plate. The size of your cropped area is your choice, but the entire license plate must be visible in
the cropped version.
D. Conduct a video enhancement of the license plate in the cropped version.
E. Overlay the frame numbers as text near one of the corners of the video. Start with the first video frame as frame 0.
F. Export the final product as an MP4 file, with H.264 video encoding.
G. Select and export between one and three frames of your choice (as PNG, BMP, or TIFF image files) which you believe
represent the clearest images of the license plate.

Uploaded file name:

2-1). Note methods or tools used and settings for the video enhancement here.



 Test No. 24-5581 Data Sheet, continued Participant Code: U1234B
WebCode: X4XX4U

Additional Comments
Please note: Any additional formatting applied in the free form space below will not transfer to the Summary Report and may cause your information to be
illegible. This includes additional spacing and returns that present your responses in lists and tabular formats.



 Test No. 24-5581 Data Sheet, continued Participant Code: U1234B
WebCode: X4XX4U

RELEASE OF DATA TO ACCREDITATION BODIES

The Accreditation Release is accessed by pressing the "Continue to Final Submission" button online and can be
completed at any time prior to submission to CTS.

CTS submits external proficiency test data directly to ANAB and/or A2LA. Please select one of the following
statements to ensure your data is handled appropriately.

 This participant's data is intended for submission to ANAB and/or A2LA. (Accreditation Release section below must be completed.)
This participant's data is not intended for submission to ANAB and/or A2LA.

Have the laboratory's designated individual complete the following steps
only if your laboratory is accredited in this testing/calibration discipline

by one or more of the following Accreditation Bodies.

Step 1: Provide the applicable Accreditation Certificate Number(s) for your laboratory

ANAB Certificate No.

A2LA Certificate No.

Step 2: Complete the Laboratory Identifying Information in its entirety

Authorized Contact Person and Title

Laboratory Name

Location (City/State)
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